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A Veritable
Smörgåsbord 

Google is useful, Google is fun. Google is good for everyone.
That’s our collective sentiment after having written this little

book. You’d be hard pressed to find someone who hasn’t ever
“Googled” the Web, but as you know very well—or will soon learn—
search is just the highlight of Google’s many services. Ranging
from advertising to exploring the surface of the earth, from creat-
ing a set of items from a list to delivering the latest news, Google
is, has, and does it all.

So much of what Google provides is free, it’s delightful. We
hope here to alert you to the fact that there is such a thing as
Google Code Search; that Google Answers might just be hosting
the answer to something you’re asking and search engines aren’t
helping; that you can create a Web page using Google tools and
host it at Google, too.

Our purpose here is, therefore, essentially to wake you to the
fact that Google is about much more than search, besides, of
course, giving you brief guides on how to go about using all those
services out there. A majority of Google’s tools have been bundled
with our Digit Archive CD this issue.

The company is ever expanding its portfolio of offerings, and by
this time next year, you can expect a few more to have been added.
In addition, some of the services change in functionality and man-
ner of usage. (That’s probably why Google tends to call all its serv-
ices “Beta.”) As a result, take this book as a snapshot of some of
what Google offers right now. Since space doesn’t permit a com-
plete coverage, we’ll be exploring more Google stuff next month.

As a little exercise, Google “Google is evil.” Then look at the
affirmations. Then, don’t believe any of it. The current king of
the Internet is one of the best things to have happened to it—if not
the best. 

Introduction
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$2 million (Rs 9.5 crore) “Summer of Code” program to offer
students an opportunity to work on technical projects. The
competition attracted participants from over 90 countries; they
completed various open source projects, and also received grants.
Google is also involved with various organisations such as the
Free Software Foundation, the Java Community Process, the
Mozilla Foundation, OSDL, and the Python Software Foundation. 

1.2  Google Code

Google uses code.google.com to publish not just its free source
code but also a list of API services. APIs give developers a set of
functions they can use to extend their program’s functionality,
without actually releasing code to them. For example, you can
implement the Blogger API on your site to let users blog content
from it without Google having to release any code to you. 

The site itself is very simple in its interface, as are all Google
products. It can be divided into the following.

1. The site navigation links:  these enable users to navigate to more
specific information. It also has a search function. Some of the
links are Google APIs, Event Calendar, Open Source, Google Code
Search, and the Google Code FAQ.

2. Enhance your Web site: these lists tools that allow users to use
Google tools to provide many advanced features, and also certain
new techniques. For example, Google Webmaster Tools optimise
the user’s site coverage in the search engine’s index.

3. Reach Google users: this has tools that let programmers work on
improving certain features of a known Google product. For
example, writing a plugin with Google Desktop SDK to search
more filetypes with Google Desktop.

4. Integrate with Google: these tools allow programmers to
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Google Code (http://code.google.com) has been started as an
open source project. Here, the company releases the code for

useful pieces of Google software for developers interested in Google
technologies. For an enthusiast, nothing could have been better!
Google first released the code for four projects—Perftools,
sparsehashtable, coredumper and goopy/functional. The list has
since expanded, and you can find it at http://code.google.com/
projects.html. It is also hoped (and has been indicated) that existing
Google programs like Google Toolbar, Google Talk and Google
Desktop might be made open source.

1.1 Google And Open Source

In recent times, Google
has done its bit for the
open source movement,
including a partnership
with Sun Microsystems
to help share and dis-
tribute each other’s
technologies. As part of
the partnership, Google
will hire programmers
to help with the open source office program OpenOffice.org.

The company has also made a $350,000 (Rs 1.65 crore)
contribution to a joint open source technology initiative of
Oregon State University and Portland State University. The aim
is to encourage open source software and hardware
development, and provide computing infrastructure to open
source projects worldwide. Apart from this, Google organized a

The Google Code main window

Google Code



HTML or XML with its many tags for specifying the display prop-
erties. This allows the programmer to do amazing things using
Google Earth which is, in fact, a browser for KML files. Among
the many features that it offers, one of the best is the ability to
specify the camera angle. There is also the ability to dynamical-
ly update the KML files from remote or local servers. You can
also bookmark (the Google folks call it “Placemarking”) your
favourite spots on Google Earth and share them with friends. 

1.4 Summer Of Code

The Google Summer of Code was an International competition
that attracted participants and mentors from over 90 countries. As
part of this the participants worked on a variety of open source
software. This page provides write-ups prepared by various organi-
sations (that mentored students) on their experience of the
entire process.

1.5 Open Source Projects

The Projects page has a listing of all the projects that Google has
provided for open source development. For programmers, these
are slices of Google technology out of the labs. Apart from giving
a brief about the project, there is also a discussion forum associ-
ated with each project, wherein the user can interact with other
programmers. The only requirement for obtaining the source
code, and for posting messages on the forum is a Google account.

Some of the projects available here are AdWords API Client
Libraries, CoreDumper, GoogleTAGS, Sitemap Generator, and Testar. 

The AdWords API Client libraries is for those users who wish to
access Google AdWords accounts programmatically. It allows the
coder to develop clients for the same purpose, and for this, it
provides the entire Java Client library in a single file.
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integrate their own programs / tools / services with those of
Google. For example, the Google AdWords API allows one to
manage an AdWords account programmatically.

5. Google Code Blog: an interesting and informative place where
visitors are updated on all the latest undertakings by Google, its
engineers, organisations associated with Google, and the grants
given by the company. Users can subscribe to the blog and be
updated about all the developments. Besides, there is a discussion
list for each product on Google Groups monitored by external
developers and the concerned Google engineer.

6. Featured Products: a column that presents some promising tools
that programmers have contributed for use by all. Each product
description is accompanied by details such as the tools and APIs
used.

1.3 Google APIs

The APIs provided by Google here are fairly extensive. These are
powerful tools that provide programmers with many features to
enhance their productivity and projects. Some of the prominent
and useful APIs are as follows.

1. The AdWords API allows development of programs to interact
directly with the AdWords server. This is particularly useful for
advertisers to manage their AdWords accounts and campaigns
more efficiently.

2. The Google Desktop SDK allows users to integrate Google
Desktop into their own applications, and also to customise it to
their needs.

3. Google Earth KML: Keyhole Markup Language (KML) allows for
modelling and storing of geographic information for display in
Google Earth. Browsers process KML files in the same manner as



1.8 Google Gadgets

These are very small
applications that inte-
grate with the Google
homepage, Google
Desktop, or any page on
the Web to enhance the
user experience.
Examples include calen-
dars and media players—
you will find 40 of these
gadgets on this month’s Digit Special CD. Google Gadgets come in
two variants: universal gadgets and desktop gadgets.

The variants serve different purposes. While universal gadgets
can be used on Web pages, desktop gadgets can be used within
Google Desktop. These make integration with various other Google
applications much more easier, and can be customised to react to
user defined actions.

1.9 The Google Maps API

The Google Maps API
allows the user to embed
Google Maps into their own
Web pages. It does this
through JavaScript. As of
now, it is an ad-free service
(though there is a possibili-
ty that it might go paid). To
begin with, create an API
key that links your Web site
and the specified directory
(during the key creation). Thereafter, integrating Google Maps is
really easy—all you need to do is add the Google JavaScript code to
the page, and voila—you have a new addition to your Web presence.
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Another great project is GData Client Tools, which provides the
source code and libraries for a variety of languages to access data
using the GData APIs.  Now, the said APIs provide a protocol for data
accessing and publishing on the web.

The Sitemap Generator is a nifty little script that makes your
Web site more Google-friendly. It provides tools that automatically
create a sitemap, which can then be submitted to Google for better
search returns.

1.6 Project Hosting

Project Hosting is a new addition to Google Code, and reads a
very interesting tagline: “Release early, release often.” This
allows users to post their own projects on Google Code. The proj-
ects have been classified under Python, C++, Java, Database, etc.,
and the user can also search for specific projects using the
search function.

Creating and submitting a new project is very simple. On the
same page, click on the “Create a new page” link, and provide some
information pertaining to the project. Among other things, you
need to select a license under which the project will be provided.
The license will decide how others can use or access the project.
Also, the label under which the project fits needs to be specified.

1.7 Google Code Search

Code Search is the one-stop place for searching through piles of
publicly-accessible source code available on the Internet. It is like
a programmer’s almanac, wherein one can even search for func-
tion definitions and sample code. The Google Code Search is dif-
ferent from the standard search feature available on
code.google.com—more about this later in this book. 

A Google Gadget

The Google Maps API



1.10 The Google AdWords API

Developers can use this API to develop programs that allow direct
interaction with the AdWords platform, and is therefore very use-
ful for advertisers and third-party systems. They can be config-
ured, customised and developed according to the user’s require-
ment and creativity. Among other things, one can use it to gener-
ate automatic keywords, URLs, custom reports, and more. 

1.11 Google Data APIs 

This is also known as GData, and provides a simple, standard pro-
tocol for reading and writing data on the Web. It uses the Atom or
RSS formats, and in many ways extends their feature set and appli-
cability on the basis of their inbuilt extension mechanism. The
publishing system conforms to the Atom Publishing Protocol.

The beauty is that GData is programming language
independent, letting the programmer develop his client software in
any language that supports the HTTP protocol. GData has been so
designed that it provides the information in mediums other than
just the browser—like feeds, queries, and results that the can be
customised to suit one’s needs. Further, GData allows the user to
exchange data with Google as well as update already present data.  

1.12 Google Code: The Future

It is expected that in the times to come, more mainstream and
popular Google technologies will be made available to the public
domain. The efforts undertaken by Google in this direction prom-
ise greater action.

1 GOOGLE CODE
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In the recent past, some companies have started Internet code
search engines—Coders and CodeHound, for example. However, it

wasn’t until Google came out with Code Search (www.google.com
/codesearch) that industry watchers and programmers stood up and
took interest.

2.1 Code Search (www.google.com/codesearch)

The Internet is a huge repository of source code written in various
languages—new, current, and defunct. Much of this code is kept in
publicly accessible domains. However, the real issue is being able
to locate such domains. Google Code Search takes advantage of the
archives on the Web that index code, as also repositories from
SourceForge and Google Code, both of which host open source
projects.

Google’s regular Googlebot crawler is being used to crawl
through archives (.tar, .zip, etc.) and repositories such as CVS and
Subversion, and index all the individual files within.

Google Code Search



2. Exact string—to search for an exact string, enclose the search
string within double quotes. For example, “hello world” 

3. file:regexp—this searches only in files or directories matching
the regular expression.

4. package:regexp—this searches for packages containing the spec-
ified expression. This presents a list of archives in the ZIP or TAR
formats, for example.

5. lang:regexp—this crawls through the repositories for code writ-
ten in the specified language. For example, you could use the
search string “lang:c++ hello world”.

6. license:regexp—this searches for code available under a particu-
lar license. To cite an example, the search string “license:bsd
hello world” gets you all code licensed under the BSD license,
containing the words “hello” and/or “world”.

2.3 Advanced Code Search

The Advanced Code Search page is for more specific search
queries. For instance, it provides a list of the programming lan-
guages that correspond to your search requirement. Your results
will turn up even if the language you’re looking for is not listed—
just select “any language.”

2.4 The Benefits of Code Search

Code Search allows coders to refer to a number of sources, compare
their own code or to get ideas on how to tackle a particular issue.
According to programmers, this removes roadblocks that existed
earlier, since it provides different ways of approaching a particular
programming problem. Code Search could also allow code auditors
to warn people much sooner of vulnerabilities in a program. A cen-
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The service is designed to be intuitive in manner and conduct.
The user can use regular expressions (search for patterns of words
rather than keywords) to search for more precise results. Searches
can be restricted by language, license, or filename, and the user can
trace the link right back to its originating package and Web page.

Google has also released the API for Code Search, which utilis-
es Google’s GDATA API format (http://code.google.com/apis
/gdata/index.html).

One important thing to note is that Google Code Search is dif-
ferent from Google Search (the standard search engine), and there-
fore, the results of Code Search results are not integrated into the
main Google index.

2.2 How To Search

The Code Search interface is sim-
ilar to the standard Google
search page. However, the first
thing anyone would notice is the
set of syntax instructions and
examples given right under the
search function.

1. regexp—a regular expression is
meant to search for a pattern
of words rather than a set of
keywords. For example,
“hello,\world”. When this is
used, the search engine opens
up the result page that dis-
plays code corresponding to
that requirement.

The Google Code Search Syntax

A Google Code Search Result
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tral argument for open source software has been that security is
enhanced by more people looking at the available code. Another
probable and important use for Google Code Search is that it
allows developers to do searches for their own code and see where
is it being used. A positive implication is that it may also help to
combat plagiarism and software license use violations. 

Google has a mechanism to tackle illegal postings and plagia-
rism. The moment it is notified of fraud, it initiates an inquiry,
and if proven true, the entry is removed from the index.

2.5 Threat Perception

Google Code Search enables open source repositories to be mined
with ease. As a result, security professionals across the globe have
issued warning statements to developers. The reason is very sim-
ple—vulnerable programs / services can be easily targeted. As the
search engine sifts through code with suitable modifications, it
can be made to parse for flaws. Yet, the dangers are manifold. A
simple query may spring many surprises. For example, one review-
er used “todo+security” as the search query and obtained many
programs with unimplemented code properties.

The only thing that can be done for sure is to educate pro-
grammers on secure programming techniques to know what is
dangerous and what is not. Frequent code reviews are a must, and
finally, coding policies need to be enforced.

2.6 In Conclusion

What began as a service for Google programmers to search
through internal company code is now available for a global audi-
ence. The promise it holds of alleviating the problem of finding
and sharing code may usher in a new age of programming pro-
ductivity and give a fresh boost to the open source movement.
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The Google Web Toolkit (GWT) (http://code.google.com
/webtoolkit/) has been designed to provide a complete

environment for programmers to develop dynamic and
standardised content. Its most outstanding feature is that while the
programmer prepares the front-end in Java, the GWT compiler
converts the code into compliant JavaScript and HTML for the
browser.

As of now, all the
major software play-
ers of the world are
into developing
AJAX frameworks.
GWT  marks
Google’s entry into
this segment, and it
has come with a
fresh approach.

3.1 GWT: The Facts

GWT makes it very easy to develop
and debug AJAX applications with
ease. The choice of the Java tools to be
used depends on the user. Now, AJAX
is a technology to build dynamic Web
pages like the Gmail interface on the
client side. It follows the client-server
architecture wherein the data is read
from and sent to the server by
JavaScript requests. 

Google Web Toolkit

The GWT Web site

The GWT Interface

Proofed - 03_Chapter03_Google Web Toolkit.qxd  5/12/2008  2:10 PM  Page 21



To install GWT, the first and primary requirement is to have
the Java SDK installed on your machine. You can get the Java SDK
from http://java.sun.com/j2se/1.4.2/download.html. The GWT
can be downloaded from code.google.com/webtoolkit/down-
load.html.

All the GWT files are located in an extracted directory, as it
does not have any installer application. The most important file
for using GWT is applicationCreator. This file is responsible for
generating batch files, support classes, and directories for the new
GWT project. For a new user, Google provides some sample appli-
cations with the GWT—it is always a good idea for a newbie to
familiarise oneself in uncertain waters.

3.4 GWT: Behind The Scenes

There are two modes of opera-
tion for a GWT implementa-
tion. For a user, it is interest-
ing as well as helpful to know
about these. 

1. Hosted mode: here the
application is run as Java
bytecode within the Java
Virtual Machine (JVM). The
advantage of running the application in hosted mode is that
since it is within the JVM, the user can utilise the debugging fea-
tures of Java from within the comfort of an IDE (Integrated
Development Environment).

2. Web mode—the application is compiled from the Java source
code to pure JavaScript and HTML with the GWT Java-to-
JavaScript compiler. Therefore, the end users interact with only
the Web mode version of your application. 
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The entire process of coding (that the programmer prepares in
Java) to the dynamic, interactive content viewed on the Web site
takes place in a sequence:

1. The programmer prepares a Java application using the GWT
libraries (a set of functions and routines grouped together for
ease of use)

2. The GWT Java to JavaScript compiler converts the code into
JavaScript and HTML files. These files usually work with all
browsers, but some may require certain settings to be changed
or edited. 

3.2 The Code: Need to change?

The next question that arises is about the need to translate the
code written in Java to be converted into JavaScript. The reason is
very simple from the point of view of programming. Java offers
one of the most versatile packages for the total development of
applications. When we combine this power and versatility with
GWT, we obtain a tool upon which the AJAX development plat-
form thrives.

Since the GWT is compatible with all the prominent Java devel-
opment tools such as Eclipse, JUnit, etc., common JavaScript errors
(example: type mismatches) can be easily debugged, and therefore
the result is a better product / service. Besides, Java is an object-ori-
ented language, so it allows more work to be done with lesser doc-
umentation or detailing of steps.

3.3. Obtaining GWT For Download

The GWT SDK is a complete package for development of Web appli-
cations. It comes with a compiler, hosted Web browser, and class
libraries.

An application in GWT
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Shell. This will pop up a specialised brows-
er window and load your application. On
Windows, that browser window uses the
Internet Explorer rendering engine, and
Mozilla on Linux.

The GWT Shell is the interface between
the Java classes and the special browser win-
dow, allowing the application’s client-side logic to run within the
browser even though it is implemented in Java, not JavaScript. It
allows you to test and debug your client-side logic with ease. You
can set breakpoints to pause and step through client-side event
handlers, and write unit tests to verify that the user interface
works as per the intended design. 

3. Thus far, even though our code has been tested in a browser as
if it were actual Web content, it is actually still a collection of Java
classes, and the final step is to compile these classes to efficient
cross-browser JavaScript code. The GWT compiler then reads the
source code and generates the equivalent JavaScript code.
Thereafter, the generated JavaScript code (along with the static
HTML, CSS and image files) is ready to be uploaded to your server.
The resulting code is entirely self-contained—it requires no brows-
er plugins or special server technology.

3.6 Concluding Remarks

GWT is an extremely interesting and useful development environ-
ment for Java developers (especially) who want to produce rich
Web clients and interactive Web content. Its strength lies in the
fact that it provides a powerful develop-debug-deploy environment
that can exploit the full program creation and debugging features
in IDEs such as Eclipse.
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Architecturally, the GWT is designed around four main com-
ponents that cover almost all the operations that it is capable of
undertaking:

1. GWT Java-to-JavaScript Compiler: this translates the code writ-
ten in Java to JavaScript.

2. GWT Hosted Web Browser: the browser is for running and exe-
cuting the GWT applications in hosted mode. When this hap-
pens, the code runs as Java in the JVM without compiling to
JavaScript.

3. JRE emulation library: these are the JavaScript implementa-
tions of the most widely-used classes in the Java standard class
library. For example, the java.lang package classes.

4. GWT Web UI class library: the library is a set of custom inter-
faces and classes for creating widgets—like buttons, images, and
text. This is the core user interface library used to create GWT
applications.

3.5 How To Use GWT

1. To begin, programmers need to prepare a program (client-side
code) using any Java IDE. For writing the code, you have access
to core Java classes and a library of classes (included in the GWT)
that provide features very similar to  that of JavaScript. For
example, the Document Object Model, alert boxes, etc.

Then there are Java classes for adding widgets to the page,
from simple buttons to complex drop-down menus and trees. All
these widgets are event-controlled, so one can prepare code to
respond to them.

2. Once you’re done writing and debugging your code and are
ready to test application in a browser, all you need to do is to
compile the file in the preferred Java IDE and launch the GWT

The GWT Shell
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P erhaps one of the best parts of Google.com is their “Labs”
segment, which showcases the upcoming projects and software

that Google is working on. Everything from Alpha to Beta versions
of their software and services are avilable here, and this chapter will
walk you through understanding some of the goodies on show here

Google Labs
As Google puts it, Google Labs “showcases a few of (our) favourite
ideas that aren’t quite ready for prime time. Your feedback can help
us improve them. Please play with these prototypes and send your
comments directly to the Googlers who developed them.” Essen-
tially, Google products that come under this category haven’t been
released yet, but can be used. They don’t officially fall under the
Google umbrella, and Google even says, “These technologies are still
in the beginning stages of development, so they may disappear

The Google Labs home
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WebSearch for a Planet: The Google Cluster Architecture, by Luiz André
Barroso, Jeffrey Dean, and Urs Hoelzle

Extracting knowledge from the World Wide Web, by Monika Henzinger
and Steve Lawrence

Searching the Web by Voice, by Alex Franz and Brian Milch

The Price of Performance: An Economic Case for Chip Multiprocessing, by
Luiz André Barroso

A couple of points before we begin. We will not be talking about
the following at labs.google.com, and for the reasons mentioned.

1. The Graduates of the Labs, since these are released products and
are not open to feedback; also because they have been talked
about elsewhere in this book. Ditto Google Code Search and
Reader.

2. Google Transit, because it only covers only a few cities in the US.

3. Google Trends in Chinese, because we can’t understand what’s on
the page.

4. Picasa for Linux, because Picasa has been discussed elsewhere in
this book. What you’ll find at the forum for this page is problems
people are facing with installing Picasa for Linux. If you have a
problem, post it at the forum page (http://groups.google.com
/group/Google-Labs-Picasa-for-Linux) and hope it’ll be answered.
(Space doesn’t permit a discussion of common Linux installation prob-
lems, either.)

5. Google Mars, because there’s a section devoted to it in this book.
6. Google Dashboard Widgets for Mac, because there are only three

Widgets available. Just for information’s sake, however, here’s
what the Widgets are:

without warning or perform erratically. If something’s not working
on this page, please come back and try it again later.” We should
note that one product has been in the labs since 2002! We expect it
will never graduate—we’re referring to Google Sets.

At http://labs.google.com, you can find all the Google Labs pro-
totypes, as well as those that have “graduated”—such as Google
Scholar and Google Maps. Each Labs title has two links: one for
sending feedback, and one for discussing the product, as in a forum.

Unfortunately, feedback for these products isn’t in the form of
a Web form with ratings and such: you can only send a plain e-mail
to the developer! You might be more comfortable getting to the
forums by clicking the “Discuss with others” link. You need to have
a Google Account, and you also need to join the group to be able to
post messages. You can, of course, read what others are saying
without having to join the group.

The content posted on these forums is typical of this mode of
communication, though the forums seem to be heavily moderated—
you don’t see any junk messages at all! Messages range in content
from suggestions (what Google wants), questions on usage, inter-
esting uses or features people have discovered, and such. Each group
also has a presence in the new Google Groups Beta—so there’s an
option on each groups page to “View the page in Groups Beta.”
Google Groups has been dealt with elsewhere in this book.

It’s come down to this: if you’re helping improve Google, you’re
helping make the world a better place! We urge you to join the dis-
cussions, and possibly even send e-mail directly to the developers if
you have something good enough (or bad enough) to say.

Also, at http://labs.google.com/papers/index.html, you’ll find
interesting (and some difficult) papers related to Google technology.
Some are showcased on this page, but there are more—and, naturally,
there’s a search bar for you to find what you’re looking for. Just to give
you an idea of what you can expect, here are four sample titles:
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Google’s intention and methodology here is the following: it exam-
ines the HTML markup on a page, and prioritises pages that “few
visual distractions, and pages that are likely to render well with
images turned off.” Also, Google here takes into account factors
such as “a given page’s simplicity, how much visual imagery it car-
ries, and whether or not its primary purpose is immediately viable
with keyboard navigation.”

The first thing we must ask is, how are the ~blind~ helped?
Then, how many pages have text-to-speech engines associated? If
one is blind or visually impaired, you probably have a text-to-speech
program installed anyway, in which case, what function does Acces-
sible Search perform?

The results are indeed very different. For example, many searches
bring up the Wikipedia entry as the first result. Then, a search for
“York” brought up the first result as a page that had an “accessibility”
link, clicking on which we got the following: “All text on this site is
set in a relatively-sized font. You can resize the text easily from within
your browser. You can also change the font, font colour and back-
ground colour.” The second result, too, had an Accessibility link: this
included the capability to use keyboard shortcuts to navigate the site.

Most importantly, most results pages are low-graphics. We
turned off images in our browser, and found that the pages encoun-
tered were pretty presentable.

But then, if you’re visually impaired, just ignore the images—
why restrict your search options?

Overall, this is not yet worth a try for the visually-impaired, and
certainly not for the blind. There is one use we can think of for the
site, though: if you’re on dial-up and are a frequent Googler, use
Accessible Search and turn off images to find pages that are low-
graphics! If you use the regular Google, many pages look crippled—
not so with the search results that come up here. You may not come
up with the —most— relevant search results, but when we tried it,

GOOGLE

(a) Blogger: to be able to easily publish to your Blogger blog.
(b)Gmail: which shows you your Gmails at a glance.
(c) Search History: which shows you what you’ve been searching 
for over the past few days. Not recommended if you share your 
Mac with someone, but that’s unlikely, we suppose.

7. Google Ride Finder: It’s US-based.

8. Google Suggest in Japanese: Again, none of us here are Berlitz
fans, so we couldn’t figure out what was on the page. Sorry!

9. Froogle Mobile US | Froogle Mobile UK, because we aren’t in
either of these countries.

10. Google Notebook, because this will be discussed under Google
Extensions for Firefox.

11. Google Suggest, since it’s now part of the Google Toolbar—which
has been talked about elsewhere in this book.

So here’s what this section will talk about, in alphabetical order:
1. Accessible Search
2. Google Extensions for Firefox
3. Google Music Trends
4. Google Page Creator
5. Google Related Links
6. Google Sets
7. Google Trends
8. Google Web Accelerator

4.1 Accessible Search

(http://labs.google.com/accessible/)
This is a page at which you perform regular Google searches, but the
results are different—more geared towards accessibility by “the
blind and visually impaired.”
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Imagine using the —same— instance of Firefox at both home and
office! All your bookmarks, tabs, cookies and all, visible to both
installations! That’s what Google Browser Sync does for you. It
uploads all your info to a Google server (you need a Google account).
When you set up the extension on the first computer, you choose a
PIN. Then, when you get to the second computer, say at office, you
install the extension, enter your PIN, and all your home settings
are restored. From then on, the two (or multiple, if you like)
browsers are always in sync—it’s all completely automated!

The actual installation and configuration is such a breeze, we
won’t bother going into it here. It’s a matter of clicking Next at
each step. One thing we should say is that you can stop or start the
syncing at any point—for example, if you visit a page you don’t
want synced on the other computer, you just click “stop syncing”
on the extension’s icon.

4.2.2 Google Notebook
This might seem pointless for some, but others might find it a
mighty useful extension. It’s a little like bookmarking, but instead
of keeping a tab on a URL, you keep a tab on any piece of content,
including images.

Here’s how it works: once you’ve installed the extension
(which involves not much more than clicking “install now” after
clicking the link), you’ll see a space at the bottom right of Firefox
that says “Open Notebook.” Open it, and you’ll see a little box
with a list of your “notes” (which is initially blank). Now, say you
come across something interesting—some text and an image. You
select the whole thing and right-click. In the context menu will
be an item called “Note this (Google Notebook).” Click that. The
selection will get added to your Notebook, and you’ll get an indi-
cator in that little box that lists out the first few words of what
you noted, along with the URL.

When you want to view all your notes together—reap the har-
vest of your browsing session, so to speak—maximise the Note-

we found that the results are more than acceptable. So, for example,
if you need general information on any topic—say, flowers—Acces-
sible Search is a good option.

4.2 Google Extensions for Firefox

(http://www.google.com/tools/firefox/index.html)

There are only five extensions listed on this page, of which we will
discuss only two: Google Browser Sync and Google Notebook. The
Google Toolbar has been discussed elsewhere in this book, and the
Firefox extension is just a program that makes it work with Firefox.

Of the remaining four, Blogger Web Comments and Google Send
to Phone are not compatible with Firefox 2.0 at the time of writing.
You’re either using version 2.0 right now, or you’ll soon be, so we’ll
have to wait until the releases for that version come out—plus, we’re
expecting more on this page.

Just for information’s sake, Google Send to Phone is an exten-
sion that allows you to select text on a page and SMS it to a US phone
number, provided you know the person’s cell carrier, and Blogger
Web Comments allows you to see what bloggers are saying about
the site you’re at.

Now for Google Browser Sync and Google Notebook.

4.2.1 Google Browser Sync
This is probably one of the most useful Firefox extensions ever.
Imagine this work-and-home scenario: at home, you have six tabs
open, and you’ve just bookmarked four sites. If you need to access
these tabs at work, you’ll have to bookmark these as well, and then,
to open all these ten pages at work, you’ll need to export the book-
marks and send them across by e-mail—or carry the file on your
Flash drive. As for cookies and passwords, whatever happens during
your home session is lost for you in your office session.
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charts, as seen on www.google.com/trends/music, is based on what
Google Talk users were listening to while chatting using that IM
client. Now in July 2006, Google Talk ranked #10 in the list of IM
clients, with just 2 per cent of the number of users of MSN Mes-
senger, according to Net traffic firm comScore Media Metrix—so we
can’t really that say Google Talk users represent the population at
large. The fact is that this 2 per cent is still a large number of people,
and besides, there’s no reason for those people not to be represen-
tative, so let’s just assume what’s on Google Music Trends is indeed
what “people are listening to.”

Here’s how it works: you log in to Google Talk. As with other
IMs, you can set your status to “Away,” “Busy,” etc. An additional
option is to set your status to the song you’re listening to right then!
A song needs to be playing in a supported player—the latest version
of iTunes, Winamp, Windows Media Player, or Yahoo Music Engine.
And when you set your status to the current song, Google Talk gives
you a message saying something like “Your status has been set to
Hotel California: Eagles.” Then, a Google server will pick up this
info. The Music Trends are calculated based on such information.

One might argue that the songs that figure on this list are
biased towards the Net-savvy, because someone who isn’t really isn’t
likely to bother setting a status this way. Another thing one might
say is that light music (as opposed to classical music or classic rock)
is more likely to figure.

At the page, you can click on some song titles, and do a Web
search on some others. You can see the top-of-the-charts for a lot of
genres, and for a lot of countries. When you click a clickable link,
you’re taken to a page with info about the song, a picture of the
album cover, the song lyrics, where you can buy the song and/or
album, and more.

Overall, this is just a place to discover what new music people
seem to be listening to, not for music you already know about. And
in any case, you could always do a Google search for the latest

book. You’ll be taken to a Gmail-like page that lists all your Notes,
with the images in place.

Note that you can always create a note, whether in the little
box or in the maximised view, by typing something out.

The fun part—if you can call it that—is that you can share your
Notebooks (yes, you can have more than one Notebook—one for,
say, each day, or one for “Work” and one for “Fun,” or whatever).
When you share a Notebook, you enter e-mail addresses (which
need to be Gmail addresses; if they’re not, Google will send a kind
invitation to the address(es) to create a Google ID) that will be
allowed to collaborate on the Notebook. These people will be able
to view and edit the Notes. You can also choose to create a per-
manent URL for the Notebook, which you can send out to
your friends.

So, essentially, what the Firefox extension does is add an item
to the context menu that lets you mark something as a Note.

Why you’d want to use this feature, and whether it’s a useful
thing, is up to you to decide! For your own purposes, it’s better
than bookmarking if only a certain portion—say a paragraph—of
a page is of interest. And for collaborative purposes, you can
imagine a wide range of scenarios: if you’re a student, for example,
you might actually take down notes from the Web this way, and
your friends could see what you’ve taken down, adding their com-
ments on each Note.

4.3 Google Music Trends

(www.google.com/ trends/music)

The purpose of Music Trends is to see what people are listening to,
based on the idea that Google Talk users represent the population
at large. The information about what songs are at the top of the
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4.5 Google Related Links

(www.google.com/relatedlinks/)

If you have a Web site and would like to provide your visitors with
additional, interesting info in the form of links, Google can help
you. Just visit the link above. A simple click and you’re ready to
choose the size, colour, etc. of the related links banner—which will
include the following:

1. Searches: Links to Google searches
2. News: Relevant news stories
3. Videos: Relevant videos on Google Video
4. Web Pages: Similar pages on the Web

Note that you can choose three of the four possibilities above for
the related links that will be inserted. Related news, videos, and
Web pages need no explanation; in Related Searches, you get key-
words and key phrases gleaned from your site, linked directly to
Google searches.

Your Web site needs to support JavaScript. What you’ll get after
you choose from the small set of options is JavaScript code that you
paste into your Web page code. When a visitor to your page clicks
on a related link (which you inserted), Google, of course, looks at
your page and selects what content is relevant. 

And no, you don’t get paid for inserting related links onto your
site! This is just for spicing up your page—helping your visitors find
related content, if you’d want that to happen. Definitely for you if
you’re an individual who maintains a page to educate and entertain
the public at large, and definitely not for you if you’re a business!

music—why would you care what Google Talk users are listening
to, anyway?

Just for kicks, perhaps. Worth a couple of visits at most.

4.4 Google Page Creator

(http://pages.google.com/)

We wonder why this one is still in the Labs! It’s ridiculously easy to
create a Web page with Google Page Creator—in fact, it’s as easy and
user-friendly as everything else Google. You get 100 MB of space for
your page, which will be http:// your_ google_id. googlepages.com.
The main editor appears as shown, with a friendly “Add text for your
page title here” and such. You can, of course, add links, “gadgets,” and
so on (gadgets are a whole bunch of Google offerings to spice up your
page. Fonts, styles, layouts—they’re all there. Create lots of pages and
link them together.
Add images. Change
colours. In fact, do a lot
of things. Even play
around with the HTML
code. Actually, it’s so
simple, it embarrasses
us to be telling you
how to go about
making a Web page
here. Just head to the
URL and make your
first Web site! And yes,
there is help for when
you need it.

Making your Google Page
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So what use can Google sets be, beyond the fun and games? Here
are a few scenarios (where you probably can’t use regular search
for finding what you’re looking for, or where Google Sets is more
likely to come up with an answer faster:

m You’ve forgotten most high-school maths, and you’re wondering
what the other trig terms are besides sin, cos and tan. So you
type in “sine,” “cosine,” and “tangent,” and voila—you get
“secant” and “cosecant,” along with a lot of other maths terms.

m You could use it as a thesaurus of sorts. Key in “bright,” “cheer-
ful,” and “happy,” and you get “delighted,” “joyful,” and so on.
You wouldn’t be able to Google this, but there’s always the the-
saurus to help you out in situations like this. Still, Sets has an
edge over the thesaurus, we think, because it gives you ideas.
“Delighted” is related to our three terms, and the thesaurus
probably won’t give you this.

m Your friends are presenting college seminars on Probability
Theory, Set Theory, and Operations Research. You’re looking for a
topic. Let Sets help you—check it out!

4.7 Google Trends

(www.google.com/trends)

“See what the world is searching for,” the tagline goes. This one is
simple: enter in a search phrase, and you’ll get:

Search Volume: A graph that goes along a timeline, which shows
you when the phrase or word was searched for and how much. Data
is available for three years.

News Reference Volume: A little graph underneath the main
graph, which tells you how often your search phrase appeared in the
news, according to time. Again, data is available for three years.

News Pointers: When there’s a surge in the news for a particular
term (the term you typed in), Google Trends marks the point in time

4.6 Google Sets

(http://labs.google.com/sets)

This one might seem like a toy at first. In fact, most people on the
forum for this Lab product do seem to use it like a toy—a pastime,
something mildly addictive. Here’s how it works.

You get five empty boxes, of which you fill in two or more. These
should be related—for example, fruits, such as “apple, “ “banana,”
and so on. When you click “Large Set” or “Small Set,” you’ll get
related items. So, for example, if you fill in two fruits, you get a lot
of fruit names when you click the button.

It’s not very intelligent:
for example, one user on the
forum complained that he
typed in names of various
rotund objects—“ball,”
“apple,” and so on, and that
Google Sets didn’t return
more round objects. So
don’t expect such things to
happen!

Here are a few sample
searches we did:

m We used “Bhutan,” “India,” and “Sri Lanka,” and got the names
of other South Asian countries.

m “Preity Zinta,” “Madhuri Dixit,” and “Shilpa Shetty” produced
lots of other Indian actresses, but interspersed in the results
were “myself,” “a lioness,” and “Bill Gates”! But we must note
the intelligence here: apart from the above three, the results
were all actresses—no actors!

m For the Large Set option, we used the names of five classical
composers, and got a set of a large number of composers—but
amongst the set was the word “introduction”!

Sets
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have been. As a typical
example, if you think about
the Presidential elections,
you can probably guess that
at around the time Bush was
elected for a second term,
there would be a surge in
searches for words like
“Bush” and “election” and
so on and so forth. You’d
find such obvious things—as
well as much less obvious
things—recorded in the Zeitgeist.

The main page is www.google.com/press/zeitgeist.html. (We
wonder why Google seems to think only the press is interested in
all this.) And there you’ll find a characteristically grandiose, philo-
sophical-sounding statement by Google: “What you see here is a
cumulative snapshot of interesting queries people are asking—some
over time, some within country domains, and some on
Google.com—that perhaps reveal a bit of the human condition.” 

There are three “levels” of the Zeitgeist: by week, by month,
and by year, though it isn’t organised that way.

By Week
When you click the main link—“Gaining Search Queries: Week
Ending October 30, 2006” (at the time of writing)—you’ll see the top
“gainers” in search for that week. The week you see will be the week
that just ended. This won’t be of much interest to most people, since
it’s a trend for only a week—and it probably reflects the state of the
news anyway, which is still fresh in one’s mind.

By Month
By month, a Zeitgeist has been “compiled.” It takes some time for a
monthly Zeitgeist to be compiled, so, for example, in October, you’ll
find the monthly Zeitgeist for August. This is, of course, the top

The 2005 Zeitgeist

with a letter, then gives you
a random headline from
that date.

Beneath this, you get
three tabs: what city, region,
and language the term was
searched for most in.

We used a controversial
phrase for our test search:
“gay marriage.” There were several peaks, as you can see in the
screenshot, and each has associated news items. As you might
expect, in the Regions tab, we found that it was most searched for
in the United States. In the Cities tab, naturally, cities in the states
where the news appeared showed the maximum searches. You can
get more detailed graphs using the Region and Date selector.

Google Trends can be fun (type in “sex,” and you’ll get a sur-
prise!). When it comes to utility, it’s mostly useful for those with an
online business, we expect. Apart from that, you might just want
to visit the page for the Trends equivalent of ego-surfing—in the
sense that you might want to see how in tune you are with the
world: use the search phrases you’ve been using and check whether
you’re outdated!

4.8 The Google Zeitgeist

While on the subject of Google Trends, we should touch upon the
Google Zeitgeist. “Zeitgeist” isn’t a made-up name; it’s a German
word that means “the general intellectual, moral, and cultural cli-
mate of an era,” as Google puts it (rightly). (The “Z” is pronounced
“ts” and the “g” is pronounced as in “gift.”)

The Google Zeitgeist is a compilation of information about what
people have been searching for, and what the trends in searching

Trends
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iPod inspired another new term: podcasting, which signifies pro-
ducing or listening to digital audio on that very same portable device.”

Archives
At the Zeitgeist Archives (www.google.com/press/zeitgeist/archive
.html), you’ll be able to jump from year to year. Within each year,
you’ll get the weekly lists, monthly Zeitgeists, and the year-end Zeit-
geist, as explained.

What It All Means
So how far does the Google Zeitgeist capture the “real” Zeitgeist, as
it were? We think it does so better than, for example, what you get
in a newspaper or magazine at year-end! We’ll justify that state-
ment with the following.
m In print media “Zeitgeists,” someone chooses what figures and

what won’t. At Google, the people have voted—and in massive
numbers.

m If an issue has plagued (or taken by storm, or generally interest-
ed) a certain region and no other, that will show up in Google.
For example, Hurricane Rita is unlikely to be showcased heavily
in a Japanese year-end magazine column; at Google, you’ll find
a lot of mention of the hurricane for the year it occurred in.

m For each month, Google doesn’t randomly compile a listing of
searches: like we said, the categories for August are different
from the categories for July. So, you get the idea that in August,
a lot of female singers were searched for, and that in July, the
word “Web 2.0” and all about the concept was gaining in impor-
tance and interest.

Collate for yourself the monthly reports, and you’ll see trends and
patterns no newspaper can give you.
m You’d need to stop over at Frankfurt airport in December and

get yourselves a copy of Die Welt to figure out what people in
Germany obsessed over in 2005. Your local paper won’t report
that. At Google, you can see year-end Zeitgeists for several coun-
tries—pick one that interests you.

m You’ll get real, sometimes useful information. Who’d think that
people in India—more than people in any other country—were
interested in the US Open in August 2005 (the month of the US
Open)? In the US, they were searching for football and basket-

FAST TRACK 

searches for the month, and includes several categories. The
monthly Zeitgeist format has changed over the years, and as of right
now, it’s divided into regular searches, news searches, and image
searches. Under the regular searches, we find, for the month of
August 2006, “Music to my ears” (bands), Songbirds (female singers),
European soccer, and “Unpleasant Revelations?”, each of which has
five top searches listed under it. Under that last link, for example,
we found “Dell Battery Recall.”

This categorisation changes every month, and is a sort of com-
plete, final, compiled report of what the times were like at a par-
ticular point. So, for example, under July 2006, we find no
“songbirds” category; instead, we find links to “summer travel,”
“Web 2.0,” and Movie and TV searches.

Then, since much of the Internet is still American, you’ll be inter-
ested in the “Zeitgeist By Country This Month,” where Google “regu-
larly updates Zeitgeist by Country to reflect titbits of information
relating to the searches made by Google’s global community of users.
We add more countries as we can, so check back often.” India is on the
list, so you can see what Indian searchers were searching for, by month.

By Year
The year-end Zeitgeist (for 2005, of course) is currently at
www.google.com/intl/en/press/zeitgeist2005.html. Visit the tabs—
search terms are listed, and there are interesting graphs that, like
in Google trends, reflect the correlation of events with searches.
The tabs here are World Affairs, Nature, Movies, Celebrities, and
Phenomena. (It’s different each year. This is for 2005.)

The things you get here are little article-like snippets. For
example, under Phenomena, there’s a comparative graph of
searches for “iPod,” “mp3,” and “podcast,” and it says:

“Cognoscenti may know that MP3 is the audio file format everyone
is using to hear and share music, but the name of a certain company’s
device that such files are played on is even easier to remember. Apple’s
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The big question: does it work? The simple answer: we tested it
on an “Indian Broadband” connection—Sify, to be precise—and it
seemed to improve speeds for popular sites such as BBC and CNN.
This could have been psychological, though! And don’t expect
much of a speedup from pages like http://home.ipact.nl/~user-
name!

Even if you’re on dial-up, download it and give it a try—you have
nothing to lose except for a couple of minutes! After you’ve used
it for a while, remember there’s an option in the system tray
menu that tells you how much time you’ve saved using the appli-
cation. When you see that figure go into the hours, you know the
app works.

ball! Then, where but at the Google Zeitgeist would you get info
on what kids were (and are) looking for?

m Search reflects what’s on peoples’ minds. Not so what’s in the
news. There might much of a hullabaloo in the press about a
certain piece of news, but if people don’t end up searching for
it on the Web, it doesn’t really reflect the spirit of the times,
does it?

And finally,

m Surprises! No prizes for guessing that “VAT” and “budget” would
have been searched for a lot by Indians in the pre-tax month of
March 2005, but would you expect that people were much more
interested in Aishwarya Rai than in either of these pressing
developments? Is that a sign of the times, or what?

4.9 Google Web Accelerator

(http://webaccelerator.google.com/)

This application has been designed to speed up your Internet con-
nection. Google tells us that dialup users “may not see much of
an improvement,” and it’s optimised for broadband connections.
So how does it work? First, frequently-visited pages are stored on
Google servers, so they can be dished up faster: there are
dedicated servers for Google Web Accelerator. Then, some pages
might be prefetched onto your computer in the anticipation that
you’ll visit them. And, Web data is compressed before it is sent to
your computer.

When you download and install the app, it sits in your system
tray, and you can start or stop it from there. In Preferences, you have
the option of choosing dial-up, DSL, and so on. Now when Google
says DSL, they mean speeds in the Mbps range, so if you’re on
“Indian Broadband,” you’re still best off selecting “Dial-up.”
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At Google Answers, you pay for getting your questions answered.
There are several aspects to http://answers.google.com—and we
will talk about whatever is important and interesting.

First off, Answers don’t come cheap—unless you earn in dol-
lars. You’ll understand why we say this as you go along. Besides,
with this book to help you out, you might not need to ask ques-
tions at Google Answers at all, unless you’re doing important busi-
ness research and such.

5.1 How It Works

We’ll leave out the details of what you go about clicking and so on,
since you can figure that out for yourselves when you visit the site.
What we’ll do here is give you a clear picture of what Answers is
intended to achieve.

It’s a paid service, like we said, but with the important differ-
ence that even those who aren’t paying or getting paid can con-
tribute to the answering process!

Let’s take a scenario. You’ve been Googling away for a couple of
days, looking for an answer to a question—say, “What is the state
of nanotechnology funding in the EU vis-à-vis that in the US, and
where are the real advances expected?” Now such a question does-
n’t easily lend itself to Googling, because even if you use “EU nan-
otechnology funding,” you’ll get a lot of results—and if you’re
doing serious research, it’s difficult to compile all that informa-
tion. That’s where Google Answerers come in.

These folks are actually pretty ordinary. A few of them are
experts in some fields, but most importantly, they’re good Googlers.
So what happens now is:

Google Answers



m If and when you get an Answer, you’ll get an e-mail notification.
Now, if you think the answer isn’t up to the mark, you can ask
for further clarifications, and the Answerer will try and incor-
porate changes to the answer.

m At the end of it all, if you’re happy with what you get, you pay
and possibly tip the Answerer. You also rate your Answerer. Be
wise while rating the Answerer: if someone’s rating goes below
a certain level, he can lose his job as an Answerer! A clarifica-
tion is often in order before you shoot off a negative rating.

If you’re still not happy, you can apply for a refund.

5.2 This Is No Yahoo! Answers

Yahoo! Answers, if you’ve seen it, is entirely different. It’s hardly
moderated; you’ll find hormonal teens asking puerile questions
about sex; you’ll find people submitting homework questions;
you’ll see questions like “Do you like blue?” or “What colour do
you like?” and such. People who answer the questions can say
things like “I don’t know” and post it as an answer; they might
say derogatory things about the question-asker; and so on.
Google Answers is much more formal—at least when it comes to
the people supplying the answers, as you’ll find out from our
example to follow.

All content at answers.google.com is moderated by what are
known as “Editors.” So even if you think about it as a forum, be
sure you express yourself concisely, clearly, and politely.

Which brings us to an important question: what can you ask at
Google Answers? You’ll find the answer to this question at the FAQ
section of the site, but in general, you can expect your question to
be deleted if:

m It contains explicit content
m It deals with stuff like making bombs
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m You create a Google Answers ID. This is different from your reg-
ular Google ID, and this ID will be used in all your Google
Answers transactions, so as to protect your privacy.
Correspondence concerning your questions will be sent to
your Gmail ID by default (you need to have a Google ID in the
first place in order to procure a Google Answers ID), but you
can change this.

Your Answers ID will have “-ga” appended to it—so if the ID you
create is “azsxdc”, you’ll be referred to as “azsxdc-ga”.

m After you’re done creating an ID, you post your question. There
is a 50-cent fee just for insertion. This fee is non-refundable—
even if your question vanishes into the void.

m You quote a price you’re willing to pay for your answer. These
prices are high by Indian standards. Google says on the
Answers page that you can get your question answered for “as
low as $2.00,” or but forget that figure—if you’re asking a ques-
tion like the above, you’ll need to quote in the vicinity of $50
or even $100!

m Your question may or may not be taken up by an Answerer.
Remember, Google is not God, and Google Answerers are not
gods either. If no-one thinks they can answer your question, it
will rot. If someone thinks he can, you’ll get an e-mail saying
your question is being worked upon.

m You can, at this point, post clarifications to your question. You
can include more details, what sites you referred to, and so
on. This makes it easier for the Answerer to nail down useful
information.

m In addition, random people with Answers IDs might decide to
“Comment” upon your answer. These won’t come under the
“Answers” section of your question page, but under
“Comments.” If you think a certain comment serves your pur-
pose, you can even cancel your question—unless it’s been
“Locked,” meaning an Answerer is working on it right now.



5.5 What Goes On At The Site

So how do you start? You first need a flavour for what goes on at
the site. Like we said, it’s not just submit-question-and-get-answer.
Here’s a typical “dialogue” in regards to a question. We made this
one up, but it’s inspired by a real dialogue at Google Answers.
We’re putting in this dialogue here so:

a. You get an idea that it doesn’t have to be advanced research
questions that are asked

b. You get the idea that the Answerers are more like regular peo-
ple than you might think

c. You get an idea of the freedom that Commenters have in regards
to posting their comments

The cast: Questioner, Answerer, Commenter. Remember that
Questioner is paying; Answerer will get paid; and Commenter is
there for the fun of it.

Questioner : I need pictures of the KASHMIR PARADISE.
Answerer : Do you mean Indian Kashmir or Pakistani Kashmir?
Questioner : I mean the illegally Indian-occupied Kashmir
Commenter: Questioner, please don’t get political here. Everyone
here would appreciate it if you’d be to the point. Answerer didn’t
know you call it “Indian-occupied Kashmir.”
Answerer : Questioner, I can help you find pictures of Kashmir.
Please clarify if the Kashmir Valley is what you mean.
Questioner : Yes I mean independent Kashmir valley country
Commenter: I suppose you could just do an image search on
“Kashmir” and find your pics… besides, here’s one great place to
get started: (www.xyz.com)
Answerer : Here’s what I’ve come up with, Questioner. Kashmir
does seem like a beautiful place! Some links for you to browse
through: (www. abc.com, …)
Questioner : I want to make clarification… these images are NOT
high-res I want better pics please please help me. Kashmir is THE
PARADISE on the earth.
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m It’s a homework question
m It asks about how Google and Google Answers works
m It’s vague or frivolous, such as “Do you like blue?”

And so on. This is a place for serious research.

5.3 What Can You Expect?

Typically, for a question like our nanotechnology example above,
you can expect a decently long write-up followed by lots of links
where you can find further information. For simpler questions,
you can expect brief, to-the-point answers. Like we said, you can
also expect random people to comment on your question, which
in themselves can contain a wealth of information.

What kinds of questions are answered for low prices? Here’s
one example we found: “How do you disable images in Firefox?”
The question was answered, and the price was $3, in addition to
the 50-cent insertion charge. So imagine paying $3.50 (Rs 160) for
something as simple as this!

One thing we must mention is that Google Answers can help
you get information you wouldn’t get anywhere else, in certain
cases. For example, what if you needed something translated into
a foreign language or vice-versa, for an important purpose? Online
translators hardly cut it. For a 500-word translation at Google
Answers, you can expect to pay about $100.

5.4 It’s Too Expensive!

Yes, we’re waiting for a Google Answers India, just like Yahoo!
brought out Yahoo! Answers India. Some decent rupee prices,
please. In the meanwhile, you can have fun at the site answering
peoples’ questions—as a Commenter, after having procured an
Answers ID.



m Read what other commenters have posted before making your
own post, so that there’s no repetition.

m Never include personal details in your comments.
m Try as far as possible to be unbiased and neutral. Never get into

controversial discussions unless you can manage to keep your
cool and be rational.

m If the question involves some (or a lot of) Googling, that’s when
it gets really fun! Use the techniques described in our section on
Web search.

In addition to posting comments, you might be able to get
answers to some of your own questions, at answers.google.com!
Just use the search box—and you might just find someone having
asked the question you want an answer to.

Google Answers, while not as addictive as Yahoo! Answers, is
still a pleasant place to visit during those idle-browsing sessions.
Remember, exercise restraint.
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Answerer : I’m Sorry, Questioner, and I’ll search some more. On a
different note, I’d like to say that you shouldn’t call one place “The
Paradise”—the world is full of beautiful places. For example, 
Questioner : No no the only PARADISE ON EARTH is the Kashmir…

… And so on. (Note that Questioner gets to shout because he’s
paying.) On many topics, you’ll find several commenters posting.

In the Firefox example we gave, the Answerer only stated the
simple answer about how to get rid of images in Firefox: go to
Tools > Options > Content > … etc. It was a commenter who said,
“Install Adblock and Flashblock if the irritating ads and anima-
tions are what you really want to get rid of.”

5.6 Have Fun!

Now that you have an idea of what Google Answers is about, you
can go ahead and waste lots of time answering other peoples’ ques-
tions. It depends on where your expertise or knowledge lies. Get
yourself a Google Answers ID, and choose a topic. Under
Technology, for example, the sub-topics are Algorithms, Games,
Graphics, Hardware, Internet, Operating Systems, Programming,
Security, Software, and Wireless & Mobile.

Bear the following in mind before you begin posting as a com-
menter. These, actually, apply to all forums!

m In the interest of your privacy, choose an ID that no-one can link
to you, because anything you write is indexed by Google.

m Don’t ask a question in a comment! Answerers are there to make
money, and if you ask a question in a comment, you’ll get some-
thing like “if you’d asked that in a question, I’d have answered
it for you.”

m Be polite, to-the-point, and articulate.
m Don’t make the world a more confused place by doing some

guesswork. Post only if you know something about what’s
being asked.
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You can find scientific research papers at a lot of places on the Net,
but then here’s a central place from where you can search for
them—Google Scholar (http://scholar.google.com). The interface is
typical Google, and here’s a screenshot of the results for the word
“pipelining,” with each part of the results explained in detail.

1. The Title links to the abstract of the article, or if it is available
on the Web, the complete article.

2. “Cited By” identifies other papers that have cited articles in the
group of papers. (Groups are mentioned soon.)

3. “Web Search” searches for information about this work.
4. The “BL Direct” link takes you to where you can purchase the

full text of the article through the British Library.
5. The text in green tells you where the paper or work appeared,

and other such information.
6. Under “Group Of,” you can find other articles included in this

Google Scholar
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huge store of papers available at these sites. Unfortunately, you
can’t purchase individual articles from either ACM or the IEEE—
you need to be a member.

On the plus side, you get some results from books.google.com,
which we’ve discussed elsewhere.

What Are “Scholarly Articles”?
If you haven’t ever searched for a scholarly article for research, we
should tell you a little bit about them. Many of them tend to be
inaccessible to those without the appropriate background, and a
problem is that a typical “scholarly” paper doesn’t mention what
background is required.

To elaborate a little, here are snippets from two articles we
found on the Web using Google Scholar. The search term was
“DDR memory.”

Here’s from the introduction of one of the results, DDR2 and
low latency variants, by B Davis, T Mudge, B Jacob, and V Cuppu:

The expanding performance gap between processor speeds and pri-
mary memory speeds has been characterized as a “memory wall.” Until
recently this problem has been attacked by designing the CPU to tolerate
long memory latencies, examples include: prefetching, out-of-order execu-
tion, lock-up free caches, speculative loads, data prediction, and memory-
request reordering. Now, we are beginning to see significant changes to
DRAM architecture in an attempt to improve both the bandwidth and the
latency of the primary memory system from the other side of the “wall.”
Most of these approaches…

Here’s from the abstract of another article: by T Kirihata, G
Mueller, B Ji, G Frankowsky, and J M Ross (hold your breath)!

A 390-mm2, 16-bank, 1-Gb, double-data-rate (DDR) synchronous dynam-
ic random access memory (SDRAM) has been fabricated in fully planarized
0.175-µm, 8F2 trench cell technology. The 1-Gb SDRAM employs a hybrid bit-

group of works, which you may or may not be able to access.
Examples include abstracts and conference papers.

7. You can filter through your results by author name.

It can sometimes be difficult to search for a particular paper,
because of things such as author initials, and so on. Just click on
the Advanced Search link near the top of the search bar: this page
also gives you Advanced Search tips. The fields are pretty self-
explanatory, in the literal sense that there’s an explanation to
each of them—naturally, we don’t need to go into that here!

There’s also the option, on the main page, to only search
recent articles.

Coverage in Google Scholar is strongest in science and tech-
nology. In addition, remember that not all results are “scholarly”—
meaning that if you want to cite a source in a work of yours, don’t
say “I got it from Google Scholar” as a defence of the “scholarli-
ness” of the work you’re citing!

What Do I Get?
Don’t expect all articles to be available for reading on the Web!
Like we said, some are available from the British Library for a fee.
Some results, when clicked, will take you to places such as the
ACM (Association for Computing Machinery) portal, where you
need a membership to be able to read the article. Abstracts are
almost always readable off the results page at some place or the
other, and in some cases, like we said, the full text of the article
might be available online.

Some results link to books, and they aren’t clickable—you need
to click the “group of” link. This will take you to the book results,
which, of course, demands that you whip out your wallet, wher-
ever it is that it takes you.

We’d suggest a subscription to ACM.org, the IEEE Web site
(www.ieee.org), and other such places, because there’s such a



6 GOOGLE SCHOLAR

58

GOOGLE

FAST TRACK

line architecture with 512 cells/local-bitline (LBL). Four LBL pairs are con-
nected through multiplexers to each sense amplifier (SA). Two of the LBL
pairs are coupled to the SA by wiring over two other LBL pairs using hier-
archical bitlines. This results in a reduction of the number of the SA’s to 1/4,
reducing the chip size by 6%. A hierarchical column-select-line scheme is
incorporated with a hierarchical dataline (MDQ) architecture.

Now turn off the lights, take a deep breath, and relax. You
don’t need to read that paper!

What we’re trying to get at is that if you’re a typical college stu-
dent, technical writer or such who needs to research a topic, you’ll
need to wade through some abstracts before you find something
you can read. (We’re assuming there aren’t too many PhDs
amongst you!)

Coming to the humanities, at the other end of the right-
brain/left-brain spectrum, we must remark that the results are
still scholarly, but tend to, as one might expect, consist of person-
al opinions as well as judicious analyses. Those searching for liter-
ature critiques, for example, will find Google Scholar a dream
come true.

They All Seem Paid Or Inaccessible!
That’s what it might seem for some searches. You see, books don’t
come free, and neither do most research papers—you’ll have to live
with that. What we’d like to tell you is that wading through the
results might well see you downloading exactly what you wanted—
all it takes is a little patience. There are millions of free PDFs and
such out there available for free download!

A final word: visit www.pubmedcentral.nih.gov/articlerender
.fcgi?artid=1324783 for a discussion of Google Scholar itself—its
merits and demerits and so on.
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This is a conscious design consideration intended to focus the
user’s attention on one and only one thing: searching for infor-
mation. In the upper right corner you will notice two links:
Personalized Home and Sign-in. The personalized home page takes
you to a customisable home page which you can configure with
your personal choices. See §7.3 to learn more on how to create a
Google account and personalise Google with your preferences.

7.1.1 Search Overview
The most basic search involves entering a string of keywords in
the search box and hitting the [Enter] key or clicking on the
Google Search button. You can also click the “I’m Feeling Lucky”
button; doing this will take you directly to the first Web site
that Google thinks is the most relevant. Additionally, you have
two other options before clicking either of these buttons: you
can select whether Google should search the entire Web or just
pages from India. Based on the options you select, the results of
your search will differ. When you click on the Google Search
button, the results displayed are ranked according to relevance
and reliability using a complex formula that calculates the
ranking (within half a second!) based on 500 million variables
and 2 million search terms! 

7.1.2. Search Preferences
You can specify how Google behaves on your computer by setting
the Preferences accessible via the link next to the search box.

This will open a Web
page where you can
specify various settings
on how Google should
behave. 

At this page you can
specify the language in
which the Google inter-
face should be. On the
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Search, of course, is what Google is mostly about. Evolved out of
their original research paper, The Anatomy of a Large-Scale
Hypertextual Web Search Engine (http://tinyurl.com/y98mbt), the
Google search engine is a distributed network of hundreds of
thousands of computers that take about half a second to process a
search query. Yes, one half of one second! For an overview of the
technology, go to www.google.com/corporate/tech.html.

Building on this breakthrough approach to searching the Web,
Google search has grown into a plethora of specialised services
that enables people to search the Web in so many different useful
ways. In this chapter we look at the various ways you can Google
the Web for information.

7.1 Web Search

Web search is the
most commonly
used of Google’s
services. Fire up
your Web browser,
type in http://
www.google.com
to take you to
Google’s “classic”
search page as
shown here.

Note that if you are in India, typing in google.com will auto-
matically redirect you to Google India’s home page,
www.google.co.in.

The first thing you notice is the minimalist look of the page.
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Searching With Google

Google’s classic search page

The Preferences page
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may want to
install their
language packs
as well. This
will enable
you to type in the search terms in the native language, and Google
will return the results in that language. For more information on
how to enable your keyboard to support Indian language scripts,
go to http://bhashaindia.com. However, results in Indian lan-
guages are scarce primarily due to the lack of Web sites.

Google can also translate text or a Web page between different
languages. See §7.1.4 for more details.

Like on the Preferences page, Google allows you to select the
user interface language that you would like to use. There is no dif-
ference between selecting it here or at the Preferences page. It is
primarily duplicated here to maintain logical consistency with the
context of the page.

If you are a translator, you may wish to participate in the
Google in Your Language programme. Click on the link given for
more details.

Finally, this page links you to Google’s country Web sites of
more than 145 countries.

7.1.4. Language Translation
Google’s language translation features can be accessed from the
Language Tools page or from www.google.com/translate_t.

Using this page, you can type text into the text box and have it
translated from one language to another. Currently this list is
quite small and lists only about 20 inter-language translation vari-
ations. Similarly, you can also specify an URL and select one of the
translation variants.
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Google India home page, the five most common Indian languages
are listed, but using the Preferences, you can choose additional
Indian language interfaces such as Kannada and Malayalam.

Next, you can narrow the search to one or more languages or
leave it at all languages.

Google’s SafeSearch Filtering allows you to filter the display for
sexually explicit content. By default, when Safe Search is turned
on (in the Advanced Search page—see §7.1.7), Google Web search
uses moderate filtering. You can change this to Strict filtering to
block out any inappropriate text results too.

By default, the number of results per page is 10. This can be
increased to 100, but the results will be displayed slower. 

Finally, you can click on the checkbox at the bottom if you
want the results to be opened in a new window. This may be use-
ful if you are running multiple searches and want to keep each of
the results open in a separate window. 

Click Save Preferences to save your selections and return to the
search home page. Note that this setting is cookie-based and tied
to your computer, and not to your Google User Account. Thus, if
you ever clear the cookies on your computer, you will need to go
back and reset the settings on this page.

7.1.3.Language-Specific Searches
You can do language and country-specific searches as well, as trans-
late between various languages by clicking on the Language Tools
link next to the search box.

This link takes you to the Language tools page which gives you
access to language-specific search services. You also can search sites
within specific countries in specific languages. 

If you are comfortable typing in any of these languages, you
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Language Tools Access
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English words and get translations in one of the eight support-
ed languages: French, German, Italian, Japanese, Korean,
Simplified Chinese, Spanish, and Traditional Chinese. To enable
this feature, on the toolbar, click Google > Options. In the pop-
up window, select the Browsing tab and select the Word
Translator checkbox. Click on the Translator Settings button to
select the language into which English words should be trans-
lated. Click OK when done.

7.1.5.Basic search
Searching is easy—just type in the search term(s) and hit [Enter] or
click the Google Search button. However, choosing the right search
term is important in getting the most relevant results. If the results
are too broad you can use a number of basic and advanced (see
§7.1.4) search operators to refine your results. You may use up to 32
keywords in your search term, which in practice should be more
than enough to handle even the most complex searches. The fol-
lowing list gives you examples of the basic search operators:

vacation shimla
Lists all the sites with the words vacation and Shimla. Note that
Google automatically searches for all the words in your search
term. Also, searches are not case-sensitive.

vacation shimla OR ooty 
Lists all sites with the words “vacation” and “Shimla”, or “vaca-
tion” and “Ooty”, or “vacation” and “Shimla” and “Ooty”. Note
that the OR operator should be in capitals, that is, if either “o” or
“r” are in lowercase, Google will treat it like an ordinary word.
Instead of using the word OR, you can also use the vertical bar
symbol |. Thus, the above search term can also be entered as “vaca-
tion shimla | ooty”.

“freedom at midnight”
A search term enclosed in quotes indicates that the search should
be for the entire phrase. Thus, in the above example the result will
show all the sites with the exact phrase “freedom at midnight”.

7SEARCHING WITH
GOOGLE

65

GOOGLE

FAST TRACK 

If you regularly require translation between any of these lan-
guages, you can get browser buttons by clicking on the “Get
Translation Browser Buttons” link.

Just drag the required buttons to your Links toolbar in Internet
Explorer or the Bookmarks toolbar in Firefox. The next time you
are at a Web page that you want translated, all you need to do is
click on the button for an instant translation of the page. For
example, if you are frequently on Portuguese Web sites that you
want translated to English, just drag the “Portuguese to English”
button to the toolbar and click on it when at a Portuguese site.
Google will instantly translate the site to English. Note that the
quality of translation will not be very accurate, since this is auto-
mated translation and we are still many years away from gram-
matically accurate machine translators.

Also, if you are using the Google Toolbar, you have one other
translation feature that language students might find useful.
When browsing English-language Web sites, you can point at
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The Translation browser buttons

The Google translation page
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stemming technology. That is, when searching for a keyword, not
only is the exact word searched for, but also words with related
meanings. For example a search for “cardiac arrest” will also
includes results with “heart attack”! In addition, Google is aware
of plurals and such, so if you search for “flowers”, pages with just
“flower” in them will show up too.

7.1.6. The Anatomy of a Search Result
A Google search result is a complex rendering of information
from multiple data stores that is displayed in a quick and easy-to-
understand format. Other than the complex formula applied to
rank the results, the results displayed will also vary according to
the type of search term. 

For example, if you search for “Windows Vista”, you will not
only be able to see the most relevant Web sites, you will also be
shown the latest news clippings. This can become very useful espe-
cially when you are searching for information related to current
affairs. In addition, Google displays advertisements—Google
AdWords, which closely match your keywords.

However if you search for the term “streptomycin”, Google
recognises that you are searching for information on medicine,
and provides you with relevant additional filters to help you refine
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This can be particularly useful when you are searching for proper
names, snippets of famous quotes, song lyrics, and such. 

caricatures where sketches +are not permitted
By default, Google ignores common words like “where”, “how”,
“are”, etc. If you want to include a specific common word, use the
plus sign before the word. Also, Google, by default, will include
spelling variations of the same keyword. Thus if your search key-
word is “colouring book”, the Google results will include both
“coloring” and “colouring”. To search only for “colouring”,
include the plus sign: “+colouring book”. Make sure there is a
space before the sign and no space between the plus sign and the
word you want included in your search results.

caricatures -sketches
If you want to exclude a particular word from your search results,
you can use the minus sign. Like the plus sign, make sure there is
a space before the sign and no space between it and the word you
want excluded.

These basic search operators can also be combined in one or
more ways to give you refined, highly focused results for your
search. For example, consider the search term:

job vacancy erp senior “project manager” -junior manufac-
turing OR Automotive

This search term will search for sites:
m with the words job AND vacancy AND erp AND senior 
m with the phrase “project manager”
m without the word junior
m with the word manufacturing OR automotive OR both

To see the difference between this search and a simple keyword
search, compare it with the undifferentiated search term “job
vacancy erp senior project manager manufacturing automotive”.

One additional feature of Google search is automatic word
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The search results page also shows you results from news items 
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your results. This feature is part of the Google Co-op service which
is explained in greater detail in another chapter.

Similarly, depending on the search terms, you may see rele-
vant supplemental results based on additional information avail-
able, your personalised search settings, or subscription to other
Google services. For example, searching for a book author may
show up additional results from Google Books Search (see §7.6).

Google also stores copies of many Web pages in a temporary
cache, which becomes useful when the main site is no longer avail-
able or has gone temporarily offline. These will appear beneath
the main results as links. In addition to the cache, if possible, the
result will also show a link to pages that are similar to the result.
And if you are using Firefox and the Google Notebook extension,
you will also see a link called “Note this”. Clicking that link will
create an entry in Google Notebook with a link to the site in the
result. See Chapter 4 for more on Google Notebook.

7.1.7. Google Power Search
The real power of searching with Google comes when you start
using the advanced search operators. There are two ways you can
use Google advanced search options. One is through the Google
Advanced Search page (click on the Advanced Search link next to
the Google search box, go directly to www.google.com/
advanced_search, or by using the operators themselves. The deci-
sion to use to the advanced search page or the operators directly
will depend on the complexity of your search. If your have a com-
plex search query it is generally easier to use the Advanced Search
page. However if you want to filter your searches on only one or two
parameters, using the search operators directly may be easier.

Most of the options in this page are self-explanatory. A couple
need some clarification. One is the Usage Rights filter. This enables
you to restrict your searches for content that have specific rights
associated with them. For example, if you are looking for content
that you can use, share and modify commercially, this filter will
enable you to find sites that implicitly allow you to do so. The sec-
ond is the SafeSearch filter. This will filter out any results with
adult content. However, it is better to specify this setting through
the Preferences page, as Web searches tend not to be filtered for
adult content even with SafeSearch filtering turned on. To learn
how to configure your Google search preferences, see §7.1.2. Many
of the options on the advanced search page are available as opera-
tors that can be used independently and are applicable to other
search services like image search and product search (Froogle) too.
These and other advanced search operators are explained here:

7.1.8. Advanced Topic
Search
The advanced search
page also links you to
various specialised topic
specific searches. These
can be very useful when
you want to search for

Google Co-op Search Results

Google Co-op:
Helps you

refine your
search

Elements in Search Results
Advanced Topic Specific Search
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content within a single area
of interest. 

The searches are opti-
mised for the specific topic
area and search queries on
these pages will return
results that are drawn exclu-
sively from the sites that are
considered part of this
topic.

7.1.9. Special Operators
Other than search-related
operators, Google also pro-
vides you with a quick and
easy way to find definitions
and meanings of words, and
do basic mathematical calcu-
lations and conversions,
using the search box.

7.2. Image Search

If you want to search for
images, a quick and efficient
way is to use Google Image
search. Click on the Images
link above the search box on
the google.com (or
google.co.in) homepage to
take you to the image search
home page.

Alternatively, type in
your search term in the

Operator

~
site:

number..number

filetype:ORext:

link:

books

cache:
info:orid:

related:

allinanchor:

inanchor:

allintext:

intext

allintitle:

intitle:

allinurl:

inurl:

Meaning

Synonym and glossary search

Search only within the site.

Search within a range of numbers 

Search for specified file types only

Searches for pages that point to the
specified URL
Search the full text of books

Show the cached version of a Web site.
Show information related to a Website
or page

Show sites that are similar or related
to the specified URL
Show pages with text that appear in 
the link or anchor text

Show pages for the given search terms
and the anchor text 

Show pages only with the specified
keywords

Show pages where the given search
term includes the specified keywords.
Show pages where all search
keywords appears in the title 
Show pages with both the search
terms for pages and title text

Show pages where the URL contains
all the words
Show Web pages where the search
term and the URL text are both
present

Explanation

Searches for "job", "vacancy" and their
synonyms. 
Searches www.timesofindia.com for all pages
with the word "tsunami"
Searches for all information regarding
Mahatma Gandhi between 1900 and 1950. (In
general, though, you will need to indicate what
the numbers represent)
Search for "Website security" in ODT (Open
Office Writer) documents only.
Lists all the pages where the URL thinkdigit.com
is present.
Shows results from Google Books where the
words "atticus finch" occur in the text. (see §7.6
for more)
Shows ~Digit~'s Google Web site cache.
Google will show the following specific
information about Digit's Web site:· The Google
cache· Similar pages· Pages that link to Digit·
Pages from the Digit site· Pages that contain
the term "thinkdigit.com"
Shows sites that are similar or related to the
Website thinkdigit.com
Shows pages with links that have the text "boot
devices". That is, the text "boot devices" will be
hyperlinked to other sites on these pages.
Show pages with the phrase "red hat linux" and
with the link text containing the term "dual-
boot"
The text of the Web page must contain all the
words. Google will ignore any of the text in the
metadata 
All Web pages where Narayanamurthy is
mentioned with the text "retirement".
All pages where the title contains the words
"free", "memory" and "diagnostic"
All pages where the word "linux" appears on
the Web page and the words "free", "memory"
and, "diagnostic" are part of the title. 
All pages where the URL to the page contains
the words "linux" and "installation". 
All Web pages with the phrase "Red Hat" and
the URL with the words "linux" and
"installation"

Example

~job ~vacancy "project manager"

tsunami site:timesofindia.com

Mahatma Gandhi 1900..1950

Website security filetype:odt

link:thinkdigit.com

books atticus finch

Cache:thinkdigit.com
info:thinkdigit.com

related:thinkdigit.com

allinanchor:boot devices

"red hat linux" inanchor:dual-boot 

allintext:camping equipment hire 
himalayas 

narayanamurthy intext:retirement 

allintitle:free memory diagnostic

linux intitle:memory intitle:free 
intitle:diagnostic

allinurl:linux installation 

"Red hat" inurl:linux inurl:installation 
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search box and click on the Images link from the  homepage.

Searches are similar to Web search, where you specify the
search keywords for the images you want to find. Image search
will display all results where the search term is found in the
name of the image file. For example, typing in “moto razr”
(without the quotes) will display images of Motorola’s RAZR cell
phone.

Each search result will have a thumbnail of the image, the
name of the image file, its size in pixels and kilobytes, and the
Web address where the image was found. In some cases, where
more than one image can be found on the same site, an addition-
al link that says “More results from (Website name)” will be dis-
played below the search result.

Depending on your settings in the Preferences page (see §7.1.2),
your SafeSearch settings will be activated. The “Use Moderate

Filtering” option will filter out
explicit images.

If you wish to only see specific
image sizes in your search results,
click on the Image sizes drop down
box and select between large, medi-
um, and small images.

As with Web search, you can also
do advanced image search. The
advanced options are mostly self-
explanatory. One point to note,
though, is that Google only indexes
image files of the JPG, JPEG, GIF,
and PNG formats. It ignores all
other types of image files.

Almost all the operators listed
for Web search (see §7.1.7) can also

be used with image search except those which are logically mean-
ingless. For example, a search for “feline paws” (without the
quotes) returns 300-odd results. By using the tilde symbol, you can
expand this search to include synonyms of the word “feline” (like
“cat” and “cats”). Thus the search term “~feline paws” will return
more than 11,000 results. 

Likewise, the operators cache:, info:, related: are logically
meaningless in the context of image search. The valid “text” oper-
ators for image search are: allintitle:, allinurl:, filetype:, inurl:,
intitle: and, site:

7.3. Personalisation—The Home Page 

To personalise your experience with Google and access all Google
services, you will need a Google user account. You can create a
Google account by going to https://www.google.com/
accounts/Manage Account and clicking on the “Create an account

Operator

define
:ordefine
orwhat is
or
what are
+ - * /

% of
^
or
**
Old units in 
new units

stock:

movie:

weather

Meaning

Shows definitions of a word or a
phrase

Arithmetic operators

percentage of 
To the power of

Conversion from one unit to another

Show stock information for the given
ticker symbol
Show reviews and show times for
given movie`
Weather information 

Explanation

Define with a colon shows a list of possible
definitions for the word or phrase Define or
“what is” or “what are” without a colon show
one single definition 

Will show the result of arithmetic calculations
based on the operators used
Calculates the percentage of the given value
Calculates the value for two to the power of
eight.

Does currency conversion, weight conversion,
number format conversion and other similar
types of conversions.
Shows stock information for Infosys 
Technologies but only from the New York Stock
Exchange
Shows reviews for movies and show times (USA
only)
Shows the weather forecast for new york. US
only.

Example

define: onomatopoeiawhat is printed circuit
boarddefine onomatopoeia

10+12*5/7-1

45% of 250
2**8
or
2^8
300 dollars in Indian rupees

stock:infy

movie:v for vendetta

weather new york
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now” link. If you already have an account you can use the above
URL to log in to your Google account.

The personalised home page can collect news, information and
other tools in a convenient, single page. To access your
Personalized Home Page, type in http://google.com/ig or
http://google.co.in/ig.

If at any time you
wish to revert to the sim-
pler search home page,
you can always click on
the “Classic Home” link
in the upper right cor-
ner to take you back to
google.com. Similarly,
from the classic home
page, you can reach the
personalised page by clicking on the “Personalized Home” link in
the upper right corner.

You can either customise the personalised home page without
signing in or after you log in. In the event that you do not log in
and personalise the home page, the settings are saved in a cookie
and will be lost every time you clean out cookies. If you log in and
customise your home page, your personalisation information will
be saved under your user account on Google’s servers and will be
available whenever you log in from any computer.

Personalising your page is done by adding content from the
Home Page Content Directory (accessed by clicking the “Add more
to this page” or “Add stuff” link which will take you to
http://google.co.in/ig/directory), or in the case of RSS feeds, click-
ing on the Feed icon in the Google toolbar.

The content directory contains hundreds of components or
gadgets as they are popularly called that can be added to the home-

page. These include useful tools, and fun and educational stuff that
can be grouped under various tabs on the homepage. Content gadg-
ets can be rearranged on the home page by dragging and dropping
the content’s title bar into a new location or by moving it to a dif-
ferent tab. 

The colours of the homepage will vary according to the tabs. To
add a new tab, click on the Add Tab link.

To rename or delete a Tab click on the tab name.

If you wish to add content to your homepage from a Web site
or blog that publishes its content via RSS, you can use the RSS Feed
Icon to add the feed. 

Clicking on the Feed Icon will take you to a confirmation page
asking you to confirm your wanting to add it to your Google home-
page.

7.4. Personalised Search and Bookmarks

Once you are signed in and working with Google, you can also con-
figure and set up personalised search. This works on the premise

Your own personalised Google home page

An RSS feed-enabled Web site
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that your current search result will have something to do with
your earlier searches. To activate personalised search, click on the
“Search History” link at the upper right corner of your person-
alised home page, or go to www.google.com/psearch. This will
take you to your Search History home page.

Once search tracking is activated, Google will gather and
store information about your searches, associated with your user
account. As the information about your search patterns increas-
es, Google will customise your search results based on your
search history. Search results that are based on your search his-
tory will also include the option to turn off the Personalized
Search (Beta) for those results. This will be shown in the upper
right side of the results page.

While search history tracks searches made on the Web, Images,
News, Froogle, Video and Music, the personalised search results
only reflect the search history of the Web searches. To view the
search history of the Images, News, Froogle, Video and Music, you
can manually browse through these sections or run a search from
within the Search history page to search for any items which have
been found in the past.

If you wish to remove any items from your search history, click
on the “Remove items” link in the left pane which will put you in
edit mode and allow you to remove any unwanted results in your
search history. Additionally, search history tracking can be paused
by clicking on the “Pause” link in the left pane of the Search
History page. You can also completely remove Personalized Search
history by going to My Account (link at the top right corner of the
personalised homepage) and selecting the “Delete Personalized
Search” option from the left pane.

You can get a historical view of your search activity by clicking
on the Trends link in the left pane.

Also, you can add the “Interesting Items For You” gadget to

your homepage, which will give you suggestions on search terms,
pages and gadgets that are related to your searches.

Google allows you to store your bookmarks in your search his-
tory account. This makes it very convenient to access your
favourite links from any computer. 

Bookmarks are organized in labels or tags, and a bookmark to
a site can have one or more labels. For example, the bookmark PHP
Accelerators which links to the site www.ducea.com/2006/10/
30/php-accelerators/ is labelled under the heading “php”, “pro-
gramming” and “Website optimization”. Thus, when one looks
under any of these labels, the bookmark will be there for easy
access. This is a powerful way to increase the relevance of your
bookmarks. If you are using the Google toolbar in Internet
Explorer, you can sign in to your account and add and manage
bookmarks directly from the toolbar. In Firefox, a bookmarklet is
provided at the bottom of the bookmarks page that can be dragged
onto the Bookmarks toolbar folder. 

To bookmark any page from Firefox, simply click on the
Bookmarks link and in the resulting pop-up window, specify the
required details.

The name of the bookmark will default to the title of the Web
page and the URL will be automatically entered. When adding
labels to group the bookmark under, any previous labels will be
displayed in a drop-down, making it easier to choose any previ-
ously-created labels rather than create new ones with variant
spellings or synonyms.

To edit or remove the bookmark, you need to go to the Google
Bookmarks page and click on the edit or remove link next to the
bookmark. You can also edit a bookmark by clicking on the yellow
star next to it. Similarly, you can rename or remove a label by click-
ing on the Manage Labels links in the left pane.
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7.6. Book search

Google Book Search
enables you to search
the full text of books
and find information
on how you can buy or
borrow the books. To
use book search, go to
books.google.com or
books.google.co.in, or
search from the regu-
lar search box on the
Google home page.
When a search term matches content in a book, the results on the
Google Web search term will include a snippet on the top with the
results from book search. 

Clicking on the book results link will take you to the Books
search page, which will list all the books that match the search
term. Clicking on a result will show you further details of the
book. Depending on the permissions granted by the publisher of
the book the book may be viewed in the following ways:

Full view: The book can be viewed in its entirety if the book is
out of copyright, or if the author or publisher has given Google
permission that allows the entire book to be viewed. Also, you can
limit your search queries to search only Full view books.

Additionally, many full view books are out-of-copyright works
and therefore are made available for free direct download in PDF
format. These include many of the out-of-copyright classics. 

Limited Preview: The author or publisher has given the user
permission to view a limited number of pages from the book
matching the search query.

Snippet View: Shows some catalogue-like information about
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Both bookmarks and search history can be added as RSS feeds
to your personalised homepage. Simply click on the Feed icon in
the Google toolbar to add them to the homepage. Note that for
bookmarks to appear on the homepage, you need to use the label
“homepage” for the bookmark.

7.5. Blog Search

Google blog search is a customised search tool that searches only
through blogs. To access Google Blog Search, go to
http://blogsearch.google.com. It works in the same way as regular
Web search, and also allows you to use all the advanced operators
that are logically consistent with blog searches. In addition to the

other operators you can also use the following:
In regular blog search, you can refine the results of your search by

the date and time of publishing. This is same as the date and time fil-
ters in the Advanced Search page but with single-click convenience.

All the above operators can also be used via the Advanced
Search options page.

Like other advanced searches, the options are self-explanatory. 

Operator

inblogtitle:

inpostauthor:

blogurl:

Meaning

Search in the title
of the blog

Search blogs
where the
author's name is
as given
Search blogs at
this URL

Explanation

Searches for the phrase
“ricky martin” in the title of
the blog.
Search for posts with the
words “windows vista”
where the blog author is
“amit agarwal”
Search for the words
“windows” and “vista” at
the blog URL blogspot.com

Example

inblogtitle”Ricky
martin”

windows vista
inpostauthor:”amit
agarwal”

windows vista blogurl:
blogspot.com

Full view books can be viewed by all
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the book and includes a few snippets from the book that match
the search query. 

No preview available: Shows only basic information about the
book and links to where the book can be bought online or borrowed
from a library. However, the search result will include text from
within the book even if it is not present in the book’s title or index.

As with other searches, the Advanced Search page allows you
to make a more focused search.

All the books can be searched using the operators listed in
§7.1.7 that are logically consistent with book searches. In addition
to the operators listed there, the following advanced operators can
be used either through the advanced search page or directly:

As with the other search operators, all the above operators can
be combined to build powerful queries to narrow down and refine
your search.

Operator

intitle:

inauthor:

inpublisher:

isbn:

date:

Meaning

Show books with the
specified title and
containing the search term

Show books with the
specified author and
containing the search term

Show books with the
specified publisher and
containing the search
term

Show book with the ISBN
number specified
Show books published
within the given date
range

Explanation

Show books with the text
“vonnegut” and with the
words “slaughterhouse”
and “five” in the title
Show books with the text
“prisoners” and with the
word “vonnegut” in the
author's name
Show books with the text
“prisoners” and with the
words “harper” and
“collins” in the name of the
publisher
Show the book with the
given ISBN number
Show books published
between 1950 and 2000

Example

vonnegut
intitle:slaughterho
use intitle:five

prisoners
inauthor:vonnegut

prisoners
inpublisher:harper
inpublisher:collins

isbn:0802131255

date:1950-2000

7.7. Froogle (Product Search)

The Froogle (a Google play on the word frugal!) product search
allows you to search for products, their price ranges, and compar-
isons from online store to store, product ratings and reviews. At
the moment, store information is primarily targeted to the US
market, and its usefulness to Indian shoppers is limited unless the
online store supports international shipping. That said, Froogle

remains a great place to get unbiased product reviews and get a
feel for the price (just convert the dollar prices into rupees!). For
the Indian shopper, Froogle’s current usefulness is as a pre-shop-
ping tool that will arm you with the facts and figures needed to
make an informed purchase. Or, if you are planning a trip to the
USA, you can do your research in the comfort of your home and
figure out your shopping budget!

To start searching on Froogle go to froogle.google.com and
enter the name of your product. Depending on the product cate-
gory you will be given further options to refine and qualify your

Refine your product search in Froogle
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search. For example, searching for the term “digital camera” will
show you further options to refine your search by price, brand,
store, seller rating, related searches and megapixel. You can then
refine your product search based on the parameters that are
important to you.

Once you narrow
down the possible
choices, you can then
get down to reading the
product reviews before
deciding on your pick.
The product reviews are
linked under the search
results, and you can see
the number of reviews each product has. 

The reviews will have further details, and are automatically
gathered by a computer program from different sources on the
Web. On the left, the overall rating of the product is displayed
along with the total number of reviews, the number of positive,
negative and neutral reviews.

Once you’ve decided on your product, you can then click the
“Add to Shopping List” link under the search result to add it to
your Froogle “My Shopping List”. 

An entry is automatically created in your Froogle Shopping List
with the details of the product, its price and the online store. You
can click on the Edit link, which will open a text box for you to
enter any relevant notes you wish to add about the product. If you
click on the Wish List checkbox, the product will be added to your
wish list. You can then e-mail the URL of your wish list to friends

and family as a pointed
reminder as to what you
want for your next birthday!

To purchase the product,
clicking on the product
takes you to the online retail-
er’s product page. As with
other Google services, you
can use the Advanced Search Page to help you narrow down your
results.

Also, most of the search operators that are logically consistent
with product searches may be used. The following “text” operators
are valid for searching on Froogle: allintext:, allintitle:, and store:.
The first two have already been explained in §7.1.7. The store: oper-
ator is used in the following way:

7.8. Google Suggest 

Google Suggest is an innovative search tool from Google that
offers you suggestions as you type. You can access Google Suggest
in two ways: by going to the Google Suggest homepage or by typ-
ing in your search terms in the latest Google toolbar.

In both cases, as
you type in your search
term, various sugges-
tions that match your
keyword will appear
with the approximate
number of results that
are available for each
variant. This will
increase the accuracy
and efficiency of your

Operator

store:

Meaning

Show product information
from specific stores.

Explanation

Show jeans from the
Macy's store

Example

jeans store:macys

View your Froogle shopping list

The content directory home page

The Google Suggest home page
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search queries as you will have to spend less time figuring out
related keywords that you should use for a particular search.

7.9. Google Directory

The Google directory is an integration of Google’s search technol-
ogy with the Open Directory Project. The ODP, as its is called, is a
vast community of volunteer editors that maintains the most thor-
ough directory of the Web. As of this writing, the ODP has 4 mil-
lion Web sites in over 590,000 categories maintained by a team of
74,719 editors. To this project, the Google Directory adds impor-
tance ranking, smarter category search, and integration with Web
searches. The category search can be useful when you are unsure
about what to look for and have a general idea about the topic
area. To search the directory, go to directory.google.com.

Enter the search term as you would in ordinary Web search. All
the search operators (see §7.1.7) that are logically consistent with
directory search are valid. The valid “text” operators you can use
are allintext:, allintitle:, allinurl:, ext:, filetype:, intext:, intitle:,
and, inurl:

At the top of the page, a link to the related categories will take
you to further categories that may be more relevant to the infor-
mation you are searching for. In some cases, the category may have
changed, and you will be given suggestions about alternative cate-
gories to search for information. In our example search above, we
are led to the business category which contains further categories
that can be drilled down into. 

Thus, searching for a particular search term will guide you to
a relevant categories that are related to the search term, which
in turn will expand your search options as you look for parallel
information.

7.10 Google Desktop Search

The latest version of Google Desktop (version 4) has taken anoth-
er step in the direction of integrating your offline and online
data into a single searchable repository. It was initially conceived
as a software application that would bring the power of Google
Web search to your computer. Over the years, Google Desktop
(GD) is evolving into more than just a desktop search tool. As of
this version, GD is working hard to integrate data across all your
computers (home, office, laptop, etc.) enabling you to search the
full text of files, pictures, and e-mail on all your computers as
well as the messages in your Gmail account, the Web pages you
have visited, and much, much more.

7.10.1  Installation and Preference Settings
The latest version of GD can be downloaded from desktop.google.
com or desktop.google.co.in. You can also install it from our Digit
archive CD with this issue. Installing the application is simple and
intuitive. Once installed, GD will immediately get down to work
and start indexing the files on your computer.

It will ask you for permission to index and search your Gmail
messages as well as to save your Google Gadgets content and set-
tings (see §7.10.9 for more on gadgets). Enter your Google account
username and password and confirm to continue. 

It will then ask you to confirm enabling or disabling of
advanced features. Once you choose your preference, you will be
shown the Google Desktop homepage. You can further configure
other preferences by clicking on the Preferences link next to the
GD homepage search box or by right-clicking on the GD system
tray icon and choosing “Preferences…”. This will open the
Preferences page in your Web browser. The preferences are
grouped into four options: Local Indexing, Google Account
Features, Display, and Other.
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Local Indexing enables you to control how GD indexes your local
computer. These are: the ability to specify what documents should be
indexed, the ability to add indexing plug ins for document types not
natively supported by GD, the ability to add networked folders and
non-fixed drives, limit searching on specified drives and folders,
encrypting the GD index, disabling indexing of new items, and
removing deleted items from the index.

Google Account Features enables you to control whether
Gmail is indexed as part of GD index data, whether the content
and settings information for gadgets are saved on Google’s GD
servers and made available to your other computers, and whether
GD should index and make searchable your documents and Web
pages across all your computers. If you have multiple computers
(for example, a PC at work and another at home and a laptop while
you’re on the move), you can install GD and share the index infor-
mation between all of them.

Display enables you to configure how GD should display the Search
box, the Quick Search box, what the default search type is, whether the
Gadgets button should be displayed on the taskbar, the behaviour of
the Quick Find feature, how many results to show per page, and
whether desktop results should be shown when you search the Web.

Other specifies whether you give GD permission to send your
private data to Google’s servers so as to personalise your experi-
ence with Sidebar gadgets such as the News gadget, and to send
non-personal usage data to help improve GD.

Depending on how much data you have on your computer and
in your Gmail account, the indexing can take several hours.
Indexing happens in the background when the computer is idle
for more than 30 seconds. However, you can speed up indexing
and force Google Desktop to index continuously by clicking on the
Index Now link on the GD homepage. Be warned that this will
have an impact on your system’s performance, as GD indexing will
take up quite a bit of processing power.

7.10.2 Searching with Google Desktop
Searching with GD
is similar to
searching Google.
Type in the search
term and hit the
[Enter] key to get
relevant results
that match your
keywords. To do
this, you need to
access GD first. This can be done in a number of ways. Depending on
how you have set up its appearance, GD may be displayed as a
Sidebar, a Deskbar, a floating Deskbar, or it may be completely hid-
den, in which case you would double-click the GD icon to open the
GD homepage in a browser. You may have also configured the Quick
Search box (via the Preferences > Display page) which is activated by
pressing the [Ctrl] key twice.

The results displayed
are sorted on the basis of
date by default; they can
also be sorted on the basis
of relevance. The search
results can be narrowed
down to only show specif-
ic types of documents like
e-mail, files, Web history,
and chats. If you have allowed searching across computers, GD also
displays results from your other computers. 

Also, with GD installed and when searching the Web with
Google, any relevant desktop search results are displayed along
with the Web search results, if you have chosen this to happen, as
mentioned above.

Your Desktop Search results integrate with Web results

The GD Timeline View
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7.10.3 Desktop Homepage
The Desktop home page enables you to search the Desktop as well
as browse items based on their date and time. To view chronologi-
cal details of files, click on the “Browse Timeline” link. You can
click on the calendar on the right to navigate to any date where
files have been created, indexed, or viewed through GD. 

Like with regular GD search, you can also filter your searches
to show only e-mail, files, Web history and chats.

You can also find out the current status of indexing by clicking
on the Index Status link. The preferences page can also be accessed
by clicking on the Preferences link next to the GD search box.
Similar to other Google search products and services, you also
have an Advanced Search page that enables you to control what
should be searched, what words should be included and excluded,
between what date ranges, and across which computers. See
§7.10.6 for details on the advanced search operators you can use.

7.10.4 Quick Find
Quick Find is an instantaneous find feature that displays search
results as you type, saving you time and increasing the efficiency of
your searches. Quick Find will display the first six results and will
indicate how many more results are available to be viewed in the
browser. You need to enable Quick Find from Preferences > Display
before you can use it with your Deskbar, Sidebar, or the Quick
Search Box. Quick Find can also be used to launch applications. Just
type in the starting letters of any application installed on your com-
puter and Quick Find will display those in the results. In the exam-
ple below, Quick Find is used to “find” the anti-spyware application
Spybot Search & Destroy.

You can type URLs into the search box to directly jump to a site.
Right-click on any result to open that file’s parent folder. Quick
Find also enables you to use the shortcut keys [Windows] + [G] or
[Ctrl] + [Alt] + [G] to quickly access the Sidebar or Deskbar or the GD
home page, depending on your GD configuration. 

By default, if you immediately press [Enter] after typing your
search term, Quick Find will search the Web, opening the results
in a Web browser. By clicking on the Search More link, you can also
search across other Google products and services.

Applications and Control Panel items can be accessed quickly by
typing the first few letter of the item’s name. For example, typing
“Sound” will show you listing for the Sound management applica-
tions on your computer as well as the Control Panel Sound applet.

7.10.5 The Quick Search Box
The quick search box is by the far the fastest and simplest way to
access GD. After activating it from your Preferences > Display
page, simply press [Ctrl] twice to bring the Quick Search box to the
front of the screen. Enter your search terms, and if you have also
activated Quick Find, the results will be displayed as you type.

7.10.6 Advanced Search Operators
Most of the search operators used on Google are also valid in GD.
These and other operators valid on GD are:

Phrase Search: You can use quotes to search for the exact
phrase. Example: “hi dad”.

Exclude from Search: Use the minus sign to exclude the key-
word from your search results. Like with Google Web search,
ensure that there is a space before the minus sign and no space
between it and the keyword that needs to be excluded.

site: and filetype: operators work in the same way as on
Google Web search.

under: This operator restricts the keyword search to a speci-
fied folder. Example: cricket under:”C:\My Documents” will search
for documents with the keyword “cricket” in My Documents.

machine: This operator restricts the search to a specific com-
puter. Example: Airtel machine:MYLAPTOP will search for docu-
ments with the word “Airtel” on the computer MYLAPTOP.
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E-mail messages which are indexed can also be searched using
the operators subject:, to:, from:, cc:, bcc:

Examples:
subject:john job vacancy will search for e-mail with the word

“john” in the subject line and “job vacancy” in the message.

subject:(job vacancy) smith will search for e-mail with the
words “job” and “vacancy” in the subject line and “smith” in the
body of the message.

subject:”joe doe” will search for e-mail with the phrase “joe
doe” in the subject line.

lowest prices subject:laptop from:chandra will search for e-mail
with the words “lowest” and “prices” in the body, “laptop” in the sub-
ject line, and which is from any e-mail ID that has “chandra” in it.

Similar to the last example above, and as with Google Web
search, the operators can be combined (unless logically incompati-
ble) to build powerful queries that can give you more precise results.

7.10.7 Locking Search
If you want to prevent GD from being used by anybody else, you
can lock the search by right-clicking on the GD icon in the system
tray or clicking on the options drop-down in the Sidebar or
Deskbar and selecting “Lock Search”. Once search is locked, desk-
top search will be disabled, and anyone attempting to search your
computer will be asked to unlock desktop search by specifying the
Windows password of your system.

7.10.8  Sidebar & Deskbar
The sidebar is a vertical bar that GD uses to store mini software
applications known as gadgets (see §7.10.9). 

The sidebar contains a search box that can be used to search
your Desktop, and with Quick Find turned on, it will display the

results as you type. Click on the Option drop-down to control how
the Sidebar should behave. You can dock the sidebar to either the
left or right of your screen. Turning the Auto Hide setting on will
“hide” the sidebar and it will only slide out when you hover the
mouse on the screen edge where it is docked.

If the Sidebar is occupying too much screen space and you
would rather prefer it to be a compact search box just for Desktop
search, you can switch to a Deskbar from the Options drop-drown.
Essentially, this is a GD search box docked to your taskbar.

Again, if you still feel that it is crowding out the taskbar, your
next option is to have the Deskbar “float” over the desktop. The
floating Deskbar can be unobtrusively tucked away into a corner
on your screen while still being available for search at any time.

In all cases, whether you have a Sidebar, a Deskbar, or a
Floating Deskbar, pressing [Ctrl] + [Alt] + [G] or [Windows] + [G] will
focus the cursor to the search box, or if all the “bars” are turned
off, will launch the GD homepage in a browser. Of course, pressing
[Ctrl] twice will bring up the Quick Search Box, which is posi-
tioned in the centre of your Desktop.

7.10.9 Google Gadgets
Google Gadgets are interactive mini applications available in the
Sidebar. These applications are created by both Google as well as
independent developers, and can be related to anything and every-
thing! From a globe, to a clock, to Google calendar, to games, and
so many other applications that the uses are only limited by the
developer’s imagination. Gadgets also need not be restricted to
being rectangular in shape or of a size that will fit within the
boundaries of the sidebar. In fact, gadgets can be “undocked from
the sidebar and allowed to ‘float’ on your desktop.”

There is a huge directory of gadgets that can be added to GD.
To add a Gadget, click on the “Add+” button which appears when
the mouse hovers over the Sidebar.
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Preferences > Local Indexing page in your default browser. Scroll
down to the section “Don’t Search These Items” and click on the
“Add file or folder to exclude” link to add the files and folders to
be excluded from indexing.

By default, Google retains the index entries for files or folders
even if they are deleted. You can check the “Remove Deleted
Items” checkbox to remove it from the index. Also, if your files
and folders are already indexed, you will need to individually
remove the unwanted entries. To do this, search for the data you
want removed from Google Desktop, click on the “Remove from
Index” link at the top right, select each entry that is to be
removed individually, or click on “Select All” at the upper right
side to remove all entries.

This removal from the index is permanent unless the entire
computer is re-indexed and the removed items are not present in
the index exclusion list defined via the Preferences > Local
Indexing options page. Note that e-mail messages removed from
the index will not reappear unless they are re-opened and read
again. In this case, you would need to manually remove them
again using the procedure described above.

This will open the Gadget content directory where you can
browse through the available content categories or search for spe-
cific types of content.

Once you find the required gadget, click Add to add it to GD. In
our example, we’ve added the Weather Globe, which shows you the
current weather as well as the forecast. Once added to the sidebar,
click on the down arrow key at the top right corner of the Gadget
to access the configuration options and set the location for which
you want the weather information. Finally, click on the “Undock
from Sidebar” option to allow it to “float” over your Desktop.

Any hidden gadget can be brought to the front by pressing the
[Shift] key twice, or by using the Gadgets taskbar button.

This button can also be used to add Gadgets or remove the but-
ton entirely from the taskbar. You re-enable it on the taskbar by
going to GD’s Preferences > Display page.

Some Gadgets also support “sending to a friend” via e-mail or
Google Talk. For example, if you see an interesting item in the Web
Clip or News gadget, right-click on the item, select the “Send To”
option and choose your Google Talk friend, or choose to e-mail
them using your default e-mail client. 

7.10.10  Pause, Prevent or Delete Indexing 
If at all you ever wish to pause indexing or re-index the contents
of your computer, you can do this by right-clicking on the GD icon
in the system tray, clicking the “Indexing” option and selecting
“Pause Indexing” or “Re-indexing” options. You can also click on
the “Index Status...” option to open the Index Status Web page,
which will give you a summary of the current index status of the
various file types. 

You can also permanently prevent specific files and folders
from being indexed. To do this, right-click on the Google Desktop
icon in the system tray and select Preferences. This will open the
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If you want an aerial view of the world, right up to street level—
where you can make out cars and even people—look no further

than Google Earth. This is an application that gives you a 3D view
of the earth. It enables you to see high-resolution aerial and
satellite imagery of the planet and much more. Uses range from
fulfilling the insatiable curiosity of the armchair traveller to more
serious professional and official uses. In rural India, farmers are
using Google Earth pictures to prove land claims!

8.1 Installation And Basic Requirements

The software is available in three versions: Google Earth, Google
Earth Plus, and Google Earth Pro. Plus and Pro are paid versions
that support advanced capabilities useful for the avid traveller,
professional, or for organisations that need geographic informa-
tion. To learn more about their capabilities, visit
http://earth.google.com/products.html.

Here, we will focus only on the free version, Google Earth. You
can download any of the three versions from
http://earth.google.com/downloads.html. There is also a special
enterprise version, separate from these “retail versions.”

Google Earth is available for Windows 2000 / XP, Mac OS X
(10.3.9+), and Linux. To use it, you will need at least a 128 Kbps con-
nection, a computer with at least 128 MB of RAM and 400 MB of
free disk space, a 3D-capable graphics card with 16 MB of VRAM,
and a screen resolution of 1024 x 768 at 16-bit colour. To download
Google Earth (about 15 MB) and get full details of system require-
ments, head to http://earth.google.com/download-earth.html.

To install the Windows version, simply double-click the down-
loaded .exe file and follow the instructions. To install the Linux ver-

Google Earth
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locations. The full combination of maps, local business search,
satellite imagery, street-level search, and driving directions is cur-
rently limited to the following countries: Canada, China, France,
Germany, Italy, Netherlands, Spain, the UK, and the US. Other
countries have varying levels of data and satellite imagery at dif-
ferent depths of resolution.

To get an idea of Google
Earth’s capabilities, you can
use the Sightseeing folder to
get a “guided tour.” Click on
the My Places panel on the left
and select the checkbox next
to the Sightseeing folder. Click
Play. This will start an auto-
mated tour from Disney World
in the US, taking you on a cir-
cuitous route to famous landmarks around the world before end-
ing at the Google Campus back in the US.

Use the “Fly to”, “Find Businesses”, or “Directions” tabs to
enter the location you wish to search for. Subject to the limitations
of information availability, locations can be searched for by city,
country, street number, and postal code. You can also look up loca-
tion information by using the latitude and longitude co-ordinates. 

In the “Fly to” tab,
enter the name of a loca-
tion, and the 3D Viewer
will zoom into the loca-
tion.

To find a business, use
the “Find businesses” tab:
enter the type of business
you are looking for, and
limit the search to a spe-
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sion, go to the directory where you downloaded the file, open a ter-
minal window in the directory, and type at the command prompt:
“sh GoogleEarthLinux.bin” and follow the instructions. The default
location for the installation is /usr/local/google/google-earth, and to
launch it, use “/usr/local/google/google-earth/googleearth”.

To install on Mac, double-click the Google Earth .dmg file in
your downloads directory. You will be asked to confirm the licens-
ing agreement, following which the Google Earth disk image will
appear. Double-click the Google Earth disk image to display a new
window with the Google Earth globe icon. Place the icon any-
where convenient (recommended: Applications folder or
Application dock), and you’re ready to go.

For problems with installing and uninstalling Google Earth,
check http://earth.google.com/support/bin/topic.py?topic=1135.

8.2 Searching and Navigating

When you first start up Google Earth, it zooms in to a picture of
the globe hovering over North America.

From this starting point,
you can view any place or loca-
tion on earth, provided, of
course, that the appropriate
map data is available. In gener-
al, map data for all areas of
earth are available, but
depending on country and
region, the resolution of the
images will vary. You have
countries and cities where you can enter street-level information,
and Google Earth will zoom in to show you an aerial view of the
street. Similarly, for certain countries, it can help you find local
business locations and give you driving directions between two
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The Google Earth startup animation

Go sight-seeing

Fly to your search locations
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At the bottom of the 3D Viewer, a set of changing numbers
display the latitude and longitude, elevation and altitude, and
the completion progress as the picture is streamed to your com-
puter. You can use the directional arrows inside the navigation-
al circle to move in different directions. Clicking and dragging
the circle clockwise or counter-clockwise will rotate the orien-
tation of the scene.

You can also use the mouse to navigate the landscape. Clicking
the left and right mouse buttons will change the shape of the cur-
sor, indicating a change in behaviour. Using the mouse buttons
you can drag the view in any direction, zoom in or out, and tilt or
rotate the view (with the scroll wheel or middle button). 

Click and drag the scene in any direction to move the view in
that direction. By holding the left mouse button down, moving it
in a particular direction for a short distance, and then releasing it,
the scene will “drift” along that direction in a continuous motion.
Click the mouse to stop the movement. If you hold the right
mouse button down and move it down for a short distance and
then release it, the scene will start to automatically zoom in; sin-
gle-click to stop the zoom-in. Also, if you double-click on a partic-
ular point, it will start to zoom into that point continuously.
Single-click to stop the zoom-in. If your mouse has a scroll wheel
you can use it to zoom in and out.

Hold down [Alt] if you want to control the zoom to small
increments (or decrements). With a depressible scroll wheel or
middle button you can press the [Shift] key and move the mouse
up or down to tilt the view. Or you can press the [Shift] key and
rotate the scroll wheel up or down to tilt the view. You rotate the
orientation of the view by using the middle button and the [Ctrl]
key, or the scroll wheel and the [Ctrl] key. Hold down the [Ctrl]
key and the middle mouse button and move the mouse to the
right or left to rotate the view in either direction. Press the [Ctrl]
key and move the scroll button up or down to rotate the view
clockwise or counter-clockwise.
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cific area. Google Earth will
zoom into the area and high-
light all the relevant business-
es that match your keyword.
You can then further narrow it
down to an individual street by
refining your keyword data.

You can find driving direc-
tions between two locations by
entering the From and To loca-
tions in the “Directions” tab.
Google Earth will draw a route
map between the two locations
with detailed information
about the route to take. This
information can then be viewed
and printed in Google Maps by
clicking on the Printable view
link. By default, a window with Google Maps will open within Google
Earth, but this can be opened in a browser and printed, too.

You can also view a “flying route tour” by selecting the item
“Route” in the direction listing and clicking the Play button in the
bottom bar of the search panel.

Use the navigation controls at the top right to adjust the angle
and tilt of the picture or to zoom in and out. The navigation con-
trol appears as a double-lined circle with “N” on a point of the
periphery. The “N” corresponds to North, and you can use it as a
guide to orient yourself when viewing a location. Hover over the
double-lined circle and the navigation controls become visible.
The top slider is used to adjust elevation. By moving the slider to
the right, you will be able to get depth and a 3D-like quality to the
picture. The vertical slider on the right is used to increase and
decrease the altitude at which the location is viewed. Drag the
slider down to increase the height and up to reduce the height.
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Find businesses in the area

Get your driving directions
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the Places panel. You can also use HTML tags to add images either
from your hard disk or from the Internet. In the Style and Color
tabs, you can change the colour, scale (size) and transparency
(opacity) of the Label (Name) and the icon.

The View tab enables
you to choose a position for
the bookmark. Move the
mouse over each field to
get an explanation of what
the field does. In the
Altitude tab, you can
choose the height at which
the placemark should be
placed, and you can have a
line extend to the ground
from it by checking the Extend to Ground box. Once all the
required information is entered, click OK to save the placemark.
Whenever required, you can right-click on the placemark and
select Properties to edit any details.

You can now share the new placemark with the Google Earth
community via the Google Earth bulletin board system. To do so,
right click and select Share/Post.

You will be taken to the Google Earth community site, where
you will have to sign up. Due to the thousands of placemarks
being created by Google Earth community members, you will be
asked to ensure that you are not posting a duplicate; also, turn
on the Google Earth community layer before posting your place-
mark to the Google Earth community site. See §8.4 for more on
using and turning on layers. In short, the community layer
includes all the placemarks posted by the Google Earth commu-
nity to the bulletin board. This is updated every few months, and
any placemarks you submit will eventual turn up in the Google
Earth Community layer. Visit the Google Earth Community Web
site at http://bbs.keyhole.com.
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Once you’ve adjusted the tour route to an almost 3D-level ele-
vation and altitude, you can use the arrow keys or mouse to move
along the route following the purple line that indicates the direc-
tion you should take. 

You can save these directions for later reference to your My
Places folder, found in the Places panel. Collapse the folder that
contains your complete driving directions, right-click, and select
“Save to My Places”. The My Places folder is where you store your
Google Earth place data. This can help you quickly revisit places
you have been to before and want to view again, much like book-
marks. For more on marking and saving places, see §8.3.

8.3 Marking, Saving, And Sharing Places

“Placemarks” are the Google Earth equivalent of bookmarks, and
enable you to store information about a particular location.
Placemarks should be saved in the My Places folder in the Places
panel if you want them to be available during later Google Earth
sessions. Items that are in the Places panel but not saved in the My
Places folder will be stored in the Temporary Places folder, and will
be lost at the end of the session. 

To create a placemark, first select your location and choose the
ideal viewing angle you wish to store it at. Select Add > Placemark
from the menu, or press the Pushpin button on the toolbar. This
will open the New Placemark dialog box with a yellow Pushpin
button surrounded by a flashing yellow square centred in the
viewer. Enter the required details in the dialog box.

Enter a name for the placemark in the Name field. Click on the
Pushpin icon next to the Name field if you want to choose a dif-
ferent icon (from the icon palette). Use the Description field to add
descriptive text that will balloon out when you click on the place-
mark. The text can also include HTML tags. When saved, the first
few lines of text will appear as a snippet under the placemark in

Create a placemark
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example, National Geographic has a whole section of layers relat-
ed to their articles and stories. By turning on the National
Geographic layer, you can see all the geographic locations linked
to their stories. Clicking on a National Geographic placemark will
show you summary details of the particular story, links to images
and the text of the article, and perhaps even videos.

These layers are also
referred to as Points Of
Interest, and can be saved
like regular placemarks to
your My Places folder in
the Places panel. Points of
Interests can also include
commercial and business
information. Similarly,
you can turn on the
Google Earth Community
layer to view placemarks
created by the community, as well as your own placemarks sub-
mitted to the bulletin board.

You can use the View field to control the list of layer categories
that is displayed in the Layer panel. Core displays only key layers,
All Layers displays all, and Now Enabled displays all currently
enabled layers. 

3D models of buildings
can be viewed by turning on
the 3D Buildings layer, and
zooming in over a city like
New York. The aerial view
will now show an overlay of
grey boxes. Use the naviga-
tion controls to zoom in clos-
er, rotate, tilt, and navigate
around the buildings!
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You can also share the
placemark by using a KML file.
The KML file, or the Keyhole
Markup Language file, is a file
that contains information
regarding geographic features
such as points, lines, images,
polygons, and models that can
be displayed in Google Earth
and Google Maps. To save
space, the KML information is
saved as a KMZ file—a com-
pressed KML file. KMZ files can
also be opened directly in
Google Earth and Google
Maps. Right-click on the place-
mark and select Save As.
Choose a filename and click
Save. The resulting KMZ file
can now be distributed to
other users of Google Earth, and also submitted to the Google
Earth community site.

8.4 Layers

Layers are additional “layers”—literally—of geographic points laid
over the basic map data. Layers are grouped into categories and
sub-categories, and can be turned on or off from the Layers panel.
Each layer can have hundreds and thousands of placemarks. In
fact, the placemarks stored in the My Places folder are also layers
in a certain sense. Like layers, placemarks can also be turned on or
off by enabling or clearing the checkboxes.

There are many categories of layers, ranging from Terrain to
Roads to State and Country borders, among others. Each layer adds
specific geographic information related to the layer category. For
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New Placemark

Share your Placemark

Placemark from National Geographic’s
Feature Article & Photo Layer

View cities in their 3D glory
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Note this is not the same as 3D models created with Google’s
3D drawing application SketchUp. Also note that some models
from SketchUp will not will not display correctly till you turn
off the 3D Buildings layer. To learn more about Google
SketchUp, see Chapter 12.

8.5 Additional Info

This chapter has barely scratched the surface on what is possible
with Google Earth. To learn about advanced techniques and other
features of Google Earth, refer to the complete user guide, which
is available at http://earth.google.com/userguide/v4/ . Or down-
load the PDF from http://earth.google.com/userguide/v4/
google_earth _user_guide.pdf.
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Picasa is Google’s free photo organising and sharing software. It
enables you to find with instantaneous ease all the pictures

and photos stored on your computer. It also has basic one-click
editing features that enable you to edit, touch up, and apply
special effects to your photographs.

When you open Picasa, it automatically scans through
designated folders on your hard disk for new pictures and adds
them to your picture library, automatically sorting them by date
and displaying them in their respective folders. You can drag-n-
drop and rearrange your albums in any manner you wish, and
also share your pictures with friends and family via e-mail, or
share them instantly via the Hello service, or post them to
Picasa Web Albums, or print them, or make gift CDs, or even
post them to your blog! 

9.1 Installation and Setup

Installing and setting up Picasa is simple and intuitive. Download
and install the latest version from http://picasa.google.com. Once
Picasa is installed, its first task is to scan through your hard disk
and find all pictures in various locations. These are all sorted by
date and grouped in their respective folders. Once scanning is
complete, you can access
Picasa and view, organise, edit
and share your pictures.

You can use the Tools option in
the menu to specify various
settings. In the Folder Manager
option, which is the same as
the Add Folder to Picasa under
the File menu, you can specify

Picasa

Folder monitoring options in Picasa
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9.2 Importing Pictures

Pictures can be imported from
a variety of sources into
Picasa. These include e-mail,
digital camera, camera phone,
memory card reader, scanner,
webcam, CD or DVD, Web pic-
tures, USB drive, and net-
worked folders.

If the device is recognised
by Picasa, it can usually be accessed through the Import feature.
Click on the Import button at the top left corner. This will open
the Import section and allow you to access any device that is com-
patible with Picasa. In some cases you may require to reinstall the
device drivers or get updated software from the device manufac-
turer to make it compatible with Picasa. CDs, USB drives, network
folders, and other removable media which show up as folders and
drives in Windows can be accessed through the Folder option in
the Select Device drop-down.

Pictures received via e-mail and from Web sites can be saved to
folders designated as “Scan Always” (Tools > Folder Manager). They
will then automatically show up in the respective folders in Picasa.

9.3 Viewing and Organizing Pictures

Pictures can be viewed in many ways inside Picasa. The first option
is to view it as a full-screen slideshow. Click the Slideshow button at
the top of Picasa (the second button from the left) to view the
slideshow of a particular folder. You can return to Picasa at any time
by press the [Esc] key. You can also use the forward and back arrow
keys to navigate through the slideshow.

Importing into Picasa

all the folders that Picasa
should Scan Always, that is,
every time Picasa starts; fold-
ers that Picasa should Scan
Once; and the folders that
should be Removed from
Picasa. Choose each set and
apply the desired option.

The Configure Buttons option allows you to configure which
buttons are visible at the bottom of Picasa’s main windows, and in
what order they appear.

The Configure Screen-
saver option enables you to
use Picasa as the screensaver
application. Clicking on the
screensaver settings button
will enable you to control and
decide which pictures should
be shown and how they
should be displayed in the
Windows screensaver.

With the other options you have advanced and experimental
features that enable geo-tagging pictures in Google Earth, pub-
lishing via FTP, enabling duplicate files, and searching pictures
based on the colours in them. You also have the option to create
backup sets—back up and burn your picture files to one or more
CDs or DVDs. Other options that control how Picasa behaves are
managed through the Tools > Options menu. All these options are
self explanatory and intuitive.

Use Picasa to make screensavers

The Configure Buttons Window
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Each folder can also optionally have a description, accessed
by right-clicking on the folder and selecting the “Edit Folder
description…” option.

You can also search across folders by using the search box on the
upper right. Clicking on the arrow buttons shows additional options

that enable you to quickly select Starred pictures, movies, and
uploaded pictures, and to view them within a specific date range.

Special photos can
be Starred using the
Star button, and these
will show up in the
Starred folder, and
will also show up
instantly when click-
ing on the Starred
search.

Similar to applying the Star to photos that are special, you can
also add them to the screensaver folder by selecting the desired pic-
tures and going to Create > Add to Screensaver. This will launch
the Windows screensaver settings window where you can further
configure the settings to
run the computer in
screensaver mode.

You can add labels or
keywords to photos, which
can make it easier to
group and search and

Use the Search Options to quickly select images

Starred Photos

Keyword Labelling or Tagging Photos

The Normal view in
Picasa will enable you to
view each folder’s pictures
as resizable thumbnails.
The slider control (on the
left below the picture pane)
is used to change the view-
ing size of the thumbnails.

In addition to the above
two ways to view pictures,
Picasa also allows you to
view the pictures along a
timeline. This can be very
interesting if your photo col-
lection spans years. To view
the pictures along a time-
line, click the Timeline but-
ton at the top of the screen.

Pictures can be moved
across folders by simply
dragging and dropping
them into the new location.
If you want to rename a file
or a group of files, simply
select the file and go to
Picture > Batch Edit >
Rename. In the Rename
Files dialog box you can
specify a new name for the group of files and whether the date
and image resolution should be included in the filename.

You can go directly to the folder containing a picture by right-
clicking on a picture and selecting “Locate on disk” or by pressing
[Ctrl] + [Enter] or by clicking on the folder icon in the viewing pane.

Picasa Standard View - Smallest Thumbnail

Picasa Standard View - Largest Thumbnail

Rename Multiple Files
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9.4 Editing Pictures

Picture editing in Picasa is
simple. Some advanced
features have been ren-
dered in with easy, simple-
to-use and intuitive con-
trols that make editing pic-
tures a breeze. To edit a
picture, simply double-
click on it. This will open
up the picture in editing
mode with the various spe-
cial effects controls available at your fingertips.

The editing controls have been grouped into three logical sets:

Basic Fixes are to
crop and trim the pic-
ture as required,
straighten skewed pic-
tures, correct red eyes
caused by flash over-
exposure, an “I’m
Feeling Lucky” button to apply a random “fun” effect, auto-contrast
to adjust the picture contrasts, auto-color to adjust the colour fideli-
ty of the picture, and a Fill Light slider control to adjust the amount
of light in the picture.

Tuning enables you to control how
the lighting in the picture varies, and
with its easy slider controls, enables
you to adjust the controls till you get
the exact effect you are after. The one-
click fixer for Highlights and Neutral Color Picker reduces the
guesswork in choosing the right balance for the picture.

A picture in the editing mode

Editing—basic fixes

Editing - Tuning

identify in your
online Web albums.
Select the photos or
group of photos you
want to label with the
same keywords and
press [Ctrl] + [K], or go
to View > Keywords.
In the Keywords dia-
log box, enter all the
keywords you want to
associate with that
group of pictures.

If you want to hide a file or a group of files, you can select the
photo or photos, and right-click > Hide. To unhide them, click on
View > Hidden Pictures. This will show the hidden pictures as dim
and greyed-out. You can select the photos you want and right-click
> Unhide to make them visible again. Turn off the Hidden Pictures
setting when you are done to prevent people from seeing pictures
you want to stay hidden.

If you want to give a journalistic flavour to your pictures, you
can give captions to your pictures in much the same way journal-
ists do. Captions adhere to the IPTC standard, which means that
the captions are saved along with your pictures and remain
embedded in the picture when you send them via e-mail, share
them via Hello, and so on. Captions are fully editable and appear
below the picture in a bar when you are in Picasa’s Edit mode.
Click on the “make a caption” text to type in your caption. You
can edit the caption at any time by simply clicking on the caption
bar again, or delete it by clicking on the trash can at the right.

Make a Caption, or a headline, even!
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First, select the pic-
tures you want to
export. Use the [Ctrl]
key to select multiple
pictures in the same
folder. Click the Hold
button at the bottom
right corner. Similarly,
if required, select other
required pictures from
other folders. All the
pictures that are being
“held” will show up in the “holding tray” at the bottom right.
Once the selection is complete, click the Export button. This is
found at the bottom right corner. 

In the resulting dialog box, specify a folder for the exported file,
resize the images to a single size or leave it at its original size, spec-
ify the image quality for the files being exported, and click OK.

All the files will be exported and will appear in Picasa with the
new resolution and image quality under the designated folder. 

Using the above export procedure, pictures can also be export-
ed to hardware devices like memory cards and digital cameras.
The only requirement is that they should appear as removable
drives under My Computer in the Windows folder structure, when
you click on the browse button.

This export function is different from the “Save a copy” func-
tion. In the “Save a copy” function, a copy of the edited file is saved
along with the original picture in the same folder. There is no
facility to save the file to a different folder or to adjust the resolu-
tion and image quality.

Export your pictures

Effects enables you to apply
various effects. These include
things like giving it a sepia tint,
rendering it in black and white,
giving it a soft focus, and other
basic special effects. 

In addition to the above, you have standard picture rotation
controls (clockwise and counter-clockwise) and the ability to undo
all your edits. 

Also, for photography aficionados, pictures from digital cam-
eras can be imported with camera and colour histogram informa-
tion (EXIF). This information will be available in the properties of
the image (right-click > Properties) and can aid in the editing and
touching-up of the picture.

One interesting task you can do in
Picasa is to make a collage of various
pictures. To do this, just select a few
pictures and click on the Collage but-
ton. You can choose what type of
effect it should have, what kind of
background, and where it should be
stored. Once you make your selec-
tions, just click Create. You can now
print the collage out, use it as a wall-
paper or screensaver, or send it to
friends and family!

9.5 Exporting Pictures

You can use the Export function to save copies of edited pictures.
The Export function enables you to export the files to a different
folder location and also enables you to change the quality and size
of the exported image copy.

Editing - Effects

Create a collage
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screen, you can choose the lay-
out of your pictures: wallet, 3.5 x
5, 4 x 6, etc., whether the print-
ing should be shrunk to fit or
cropped to fill the full paper
area, select the printer, and
adjust the printing options.
Once you are satisfied with your
settings, you can click on the
Review button to see Picasa’s rec-
ommendations on how the printing will turn out. You will be alert-
ed to the fact when there is something wrong with your pictures by
a warning symbol (a triangle with an exclamation point) next to the
review button. If the pictures are low quality or of poor resolution,
Picasa will warn you and give you the option of excluding the low-
quality pictures from printing.

Once you review and accept or ignore the recommendations,
you can click on the Print button to print your pictures.

Like the contact sheet
(for preview) you get from
your photography studio
with thumbnails of all the
pictures on your film roll,
you can also print out a con-
tact sheet. Select the photo-
graphs you want to print.
Use the [Shift] key to select
a group of consecutive photos and the [Ctrl] key to select non-con-
secutive photos. Once selected, press [Ctrl] + [Shift] + [P], or from
the menu, Folder > Print Contact Sheet. The files you want to
print will be previewed in the printing screen and you can then
print them out.

Review photos for print

Print a contact sheet

9.6 E-mailing Pictures

E-mailing pictures in Picasa is
very intuitive and seamless. Just
select the pictures and click on
the e-mail button at the bottom
to be presented with the various
options on how to e-mail them.
You will be given the option of
using the default e-mail client,
your Gmail account, or Picasa
Mail, which requires you to have
a username and password for
the free Hello service (see §9.10
for more on Hello). 

If using Gmail or Picasa Mail, note that you can send a maxi-
mum of 10 MB as an attachment. You can, however, compose your
mail right from within Picasa without having to open a Web
browser. If you use your default e-mail program (like
Thunderbird, Outlook, or Outlook Express), the program will
open in compose mode and the selected files will be automatical-
ly attached to your message. All you will need to do is supply the
send-to address, fill in a message, and click on Send.

While you may have the capacity to send large file attach-
ments, make sure that the recipient has the capacity to receive
them. Some ISPs and Web hosting providers do not support e-
mail with large (say 9 MB) file attachments.

9.7 Printing Pictures

Printing is again simple. Select the files you want to print, click on
the Print button, review your printing options, and fire away!

After selecting and clicking on the Print button in the printing

Select your email service
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The picture upload manager will inform you of the progress of
the upload as it happens. Once completed, you can view it online,
view a slideshow, reorganise and rearrange the pictures, and share
the album with friends and family. Visitors to your albums can
download the albums to their own computer and their copy of
Picasa for offline viewing too.

Additionally, the pictures can be also be published as a RSS
feed, which makes it easier for people to subscribe to your feed and
be instantly able to see new pictures as you upload them without
waiting for an e-mail alert from you.

9.10 Using the Hello Service

Hello is a picture sharing and chatting service. You don’t require to
upload any pictures to the Web; you can directly chat with other
Hello users and share pictures with them. Hello is a companion
service to Picasa and seamlessly integrates with it. You can surf the
Web together with friends, using Web page sharing, and send
instant snapshots with webcam support. To learn more about Hello
and to download and use the software, visit http://hello.com.

Publish photos to your Picasa Web Album

9.8 Blogging with Pictures

If you are an avid blogger and you have an account with Blogger (a
Google account will do!), you can directly post the pictures to your
blog. Click on the Blog This button, log in with your Google account,
select the blog you want to post it to, the layout you want to use, and
the size of the image that should be displayed.

Click Continue and fill out the title and text of your blog post,
and click Publish.

9.9 Uploading Pictures to the Web Album

Picasa’s new Web Album
service enables you to
upload 250 MB worth of pic-
tures to the Web. This is a
free account. If you wish to
upload more than 250 MB,
you will need to upgrade to
a paid account, which will
allow you to upload up to 6
GB of pictures and m ovies.
This can then be made avail-
able online and published in
a variety of ways. 

To start, click on the Web
albums button and sign in
with your Google username and password. In the Web Albums
upload dialog box, you are asked to specify a name for the album,
an optional description, the quality of the upload, and whether it
should be available to the public or should be unlisted for sharing
only with friends and family. Make your entries and choices and
click OK.

Web Albums Upload Options
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Google Reader is Google’s free, Web-based RSS Feed aggregator,
which you can use to subscribe to your favourite RSS feeds from all
over the Web. As with most Google services you will need a Google
account to sign in and start using Reader. 

Subscribing to an RSS
feed is simplicity itself. You
can add RSS Feeds to Google
Reader by using the
Subscribe button, which you
drag and drop onto your
bookmarks toolbar (Firefox)
or the Links toolbar (Internet
Explorer). Whenever you are at
a site that allows you to sub-
scribe via RSS, you click on the
Subscribe button. For example,
the CNN Web site supports RSS. 

Clicking on the subscribe
button on the bookmarks tool-
bar will open the feed in
Google Reader, and you will
need to confirm the subscription by clicking on the Subscribe but-
ton at the top of the feed page.

Once you have confirmed your subscription, you can view CNN
stories in Google Reader without having to continually visit the
CNN Web site.

The Reader interface has many parts. The left pane is where all
the subscriptions are displayed. Every subscription will also show a
count of the posts that are unread. You can view the posts for each
subscription by clicking on it. You can use the All items link at the

Google Reader

FAST TRACK 

The Google Reader home page

Subscribe to RSS
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share the address with your friends and family to let them look at
what you are reading. 

For easier viewing, you can organise the feeds in folders by
going to the settings page (click on the link at the top right corner). 

For each subscription, you can specify one or more tags. These
tags will appear as hierarchical folders in Reader. Additionally, you
can make these tags public and publish the items under these tags
as RSS feeds. Similar to the shared page, each tag will have its own
public page, and like with the shared items, you can also create a
“webclip” for each public tag, which you can post to your site or blog.

Go to the Goodies tab under settings to see various other
options on what you can do with Reader. You can include Reader
on your personalised Google Homepage by clicking on the Add to
Google gadget link. You can also
put all Reader items in a “next”
bookmark or limit it to one of
your folders (tags). Drag and
drop the bookmark to your
bookmarks/links folder.
Clicking on Next will open the
reader to the latest post, and
subsequent clicks will enable
you to see each successive subscription at the original site. This
may be useful when you only get a snippet in your post and wish
to read the full post.

Google Reader is also available on your mobile. Point your cell
phone’s browser to www.google.com/reader/m.

You can use the Import/Export tab to import your subscriptions
from another RSS reader, or export your Google Reader subscrip-
tions. Both Import and Export follow the industry standard for
subscriptions file format, known as OPML.
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top of the left pane to auto-sort posts such that even those with
fewer entries “rise above” the high-volume, high-frequency posts.

In the right pane, the actual post items are displayed. When
you scroll through and read the posts, the unread posts count will
start decreasing. If you have more than 100 unread posts, Reader
will only show 100+ against the subscription. You can view the
posts either in List View or Expanded View. In List View, you can
quickly skim the headlines without having to wade through the
content of each post. However, note that the post will only be
marked as unread if you view it in Expanded View. If you do not
wish a subscription to show up as unread even if you don’t read
the posts, you can use the “Mark all as read” link at the top of the
right pane. This will
mark all items in the
post as read and clear
the unread count
against the subscription
in the left pane. If you
want to leave a post as
unread you can clear
the “Mark as Read”
checkbox at the bottom
of the post item.

Special posts and those you want to review again later can be
Starred. To mark a item with a star, click on the “Add Star” link at
the bottom of the post. 

You can also Share with friends the items in the feeds that you
find. On a post that you want to share, click on the Share link at
the bottom of the post. Then click on the “shared items” link at
the top of the left pane. This will show you the link to your public
page and also provide you with the JavaScript code that you can
embed on your Web site to show a linked clip of your shared items.

The public page can also be subscribed to via RSS, and you can
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Your Shared Items public page
Enjoy Reader’s goodies
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Google Pack is a collection of free software being distributed by
Google. The pack includes software both from Google and other
companies. These software are considered the essential core appli-
cations a computer user can’t live without, so to speak.

The pack requires Windows XP with Administrator privileges,
and Firefox 1.0 or Internet Explorer 6.0 and above. Included in
the pack are:

Google Software:
m Google Earth
m Picasa
m Google Pack Screensaver
m Google Desktop
m Google Toolbar for Internet Explorer

Other Software:
m Mozilla Firefox with Google Toolbar
m Norton Antivirus 2005 Special Edition 6 month subscription
m Ad-Aware SE Personal 
m Adobe Reader 7

Optional Software:
m Google Talk
m Real Player
m Skype
m Google Video Player
m GalleryPlayer HD Images

All the above software is downloaded and updated by Google
Updater. They are provided for free, and you have the ability to
specify which all software you want to download. If you indicate
that you already have some of the programs in the list, Google
Updater will verify whether you have the latest version of the prod-

Google Pack
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uct and won’t install the software if that is the case. After instal-
lation, the Google Updater will continue to sit in your system tray
and monitor for any updates to the installed software. If new ver-
sions of the software become available, the Updater will show noti-
fications of their availability for installation.
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SketchUp is a powerful 3D modelling software that enables you to
create, view, and modify 3D models. With simple, intuitive controls,
you can push and pull your 3D objects to knock them into shape.
You can use SketchUp for a variety of real-life projects—from adding
an extension to your house to making a new widget. Drawings can
be as simple or as detailed as you might want. You can use real-life
dimensions to construct your model, as well as add colours and tex-
tures. SketchUp also simulates real-life shadows (showing you how
shadows will fall when the sun falls on your model). To make get-
ting started even simpler, there are thousands of pre-drawn compo-
nents that will save you time—you don’t have to start from scratch.

12.1 Installation And Basic Requirements

The software is available in two versions: SketchUp Pro, the paid
version and Google SketchUp, the free version. For our purposes
here, we will talk about basic uses of only the free version. 

Download and install the latest version of Google SketchUp
from http://sketchup.google.com/download.html. The software
supports Windows 2000 / XP, and is also available for the Mac.
There is no Linux version at present. Details of optimum system
requirements are also on the same download page. 

12.2 Learning SketchUp

The proficiency you achieve in using SketchUp will depend on how
complex you want your 3D creations to be. The SketchUp Web site
offers a wealth of training resources to help you get started.

For the beginner to 3D Modelling, an online user’s guide is
available, which will help get a grasp of the concepts and tech-

SketchUp
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about the tool you’ve currently selected. Enable the Instructor
window from the menu (Window > Instructor). Also, whenever
you work with a tool, don’t hesitate to right-click and explore the
options that pop up with whatever object you are pointing at.
There is no faster way to learn than using the software itself.

You can also join the Google Groups SketchUp community
(http://groups.google.com/group/sketchup) and get further help
and support other newbies as they begin to use SketchUp. Also
check out the Wiki for “The Ultimate Encyclopedia for Everything
SketchUp”—www.suwiki.org. It has tons of information, tutorials,
tools, tips and tricks and more!

12.3 Components

Components are pre-built objects that are included with SketchUp
and available for download. These help in speeding up creation of
your 3D objects, as you do not have to create them from scratch. You
can explore the components that came along with SketchUp by
going to the installation folder and opening the Components sub-
folder (usually C:\Program Files\Google\Google SketchUp\
Components\Sampler). Use File > Open to open the included com-
ponents. You can also download  component sets
(http://sketchup.google.com/components.html) pre-built for specif-
ic industries such as Architecture, Construction, and Film & Stage.

12.4 3D Warehouse & Google Earth

The 3D Warehouse is an online
catalogue of 3D models that
you can search and download.
You can also create your own
3D models and share them
through the warehouse. Access
the 3D Warehouse directly

Browse through 3D models in the 3D
warehouse

niques that go into creating 3D models. Go to
http://download.sketchup.com/OnlineDoc/gsu_win/GoogleSketc
hUpHelp.htm (or http://snipurl.com/googsketch) and go through
the Concepts section to get a basic understanding on what is
involved in 3D modelling. Alternately, download the complete
user guide from http://download.sketchup.com/GSU/pdfs/
GSUUsersGuide_WIN.pdf (or http://snipurl.com/googsketch1)
and read the concepts from page 9 of the PDF document.

Once you’ve
understood the
concepts, you can
take the self-paced
tutorials to famil-
iarise yourself with
the tools and con-
trols you will use
to create and
manipulate 3D
models. If you are
running SketchUp for the first time, you will be prompted to take
the tutorials through the Tip of the Day dialog box. You can also
access the tutorials from Help > Self-Paced Tutorials. This three-
part tutorial gives you a solid grounding in using and working
with 3D objects in SketchUp. 

You can then go on to video tutorials (http://sketchup.google
.com/tutorials.html) that will show you how to work with
SketchUp, introduce you to the SketchUp 3D Warehouse, and show
you how to place the 3D models in Google Earth. Additionally, you
can print the Quick Reference card (http://download.sketchup
.com/GSU/pdfs/QuickReferenceCard.pdf, or http://snipurl.com/
googsketch2) and keep it within easy reach and access it when
working with SketchUp.

Once you begin working with SketchUp, help is at hand: just
open the “Instructor” window. This will show you information

Go through the tutorials as slow as you need

DT - Chapter 12 (Google SketchUp).qxd  5/12/2008  1:56 PM  Page 126



12GOOGLE SKETCHUP

129

GOOGLE

FAST TRACK 

12 GOOGLE SKETCHUP

128

GOOGLE

FAST TRACK

m In GE, fly to the location you wish to place the model on, look-
ing straight down.

m In SketchUp, use the Get Current View command to import a
snapshot of the terrain.

m Place your model over the terrain and ensure that it fits snugly
into any slope and elevation in the terrain. For example, you
might need to add support pillars to a building model if it is on
sloped terrain. Use the Google > Toggle Terrain menu command
to view your model in a 3D terrain. Use the Move/Copy tool if
required to position the model correctly.

m Next, use the orbit tool to rotate the model till you are looking
down directly at it.

m Select the Google > Place Model menu command to place the
model where you took the terrain snapshot.

m If you are satisfied with the results and want to share it with
others, consider uploading it to the 3D Warehouse. Select
Google > Share Model from SketchUp and follow the instruc-
tions to upload your model to the 3D Warehouse.

For more detailed instructions on troubleshooting problems
with using SketchUp and Google Earth, go to
http://sketchup.google.com/support/bin/topic.py?topic=8539 or
http://snipurl.com/googsketch3.

using a browser at http://sketchup.google.com/3dwarehouse, or by
clicking on Google > Get Models in SketchUp. Click on a model to
download it to your computer, view it directly in SketchUp, or
download it as a .kmz file that can be viewed in Google Earth.

After downloading a model to SketchUp, you can click the
“Place Model” option under the Google menu to export and view
the model in Google Earth. Use the tilt and navigation controls to
adjust the viewing angle of the model.

Note that the
models imported
from SketchUp and
downloaded from
3D Warehouse are
stored in the
Temporary folder in
the Places panel. If
you wish to perma-
nently retain these
items, you will need
to save them to your
My Places folder. See
Chapter 8 for details.

You can also create a model in SketchUp, save it, and add it to
Google Earth. To do this: 

m First create and save your model, start SketchUp, and then start
Google Earth. Starting Google Earth (GE) first may cause
SketchUp to crawl.

m Next, turn on the Terrain layer in GE and set the Rendering >
Elevation Exaggeration to 1, and the Detail Area to Medium or
Large in the menu settings: Tools > Options > View.

m In Windows, set GE to DirectX mode (Start > Programs > Google
Earth > Set Google Earth to Direct X mode). You can leave it as
OpenGL if that setting is faster and if the SketchUp menu com-
mand Google > Get Current View works without problems. 

The Statue of Liberty from the 3D warehouse, at
her rightful place in Google Earth
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Google Alerts refers to automatically-generated e-mail alerts,
based on search terms, which show results in five categories:

m News: the latest top 10 news article search results based on the
given search terms

m Web: the latest top 20 Web search results based on the given
search terms

m Blogs: the latest top ten blogs search results based on the given
search terms

m Groups: the latest top 50 posts in Google Groups search results
based on the given search terms

m Comprehensive: the latest search results for the given search
terms from multiple sources for maximum coverage

Typically, people create alerts for things like:
m Tracking a news story as it unfolds
m Keeping up to date on competitors and industry
m Monitoring medical advances
m Tracking celebrity news and gossip

You can set up Google Alerts by signing in with your Google account
and going to the alerts home page at www.google.com/alerts.

Google Alerts
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The Google Alerts home page
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To create an alert:
1. Type in the search terms on which you wish to base your search

results. This can either be a simple string of keywords, or you
can create an advanced search term using the various operators
discussed in Chapter 7, or via the Advanced search page. It is a
good idea to run a trial search with your search term to see how
the results look. If you are satisfied with the results, you can
then copy the search term into the “search terms” box.

2. Select what type of search it is, based on the five possible variants

3. Select at what frequency you want to be alerted—once a day, as-
it-happens, or once a week. Determining the alert frequency will
depend on the search topic. Fast moving topics should generally
be set to once a week, or you will be drowning in alerts! For slow-
moving topics like a specific scientific or medical breakthrough,
an as-it-happens alert will be better.

4. Click on “Create Alert” to finish.

Once the alert is created, you can sit back and wait to be updated
according to the specified frequency. The Edit and Delete next to
each alert link enables you to edit the alert—changing the search
terms, the type and frequency, and deleting the alert when it is no
longer relevant. You can also specify whether the alert should be
in HTML or plain text.
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The Google Toolbar for Internet Explorer and for Firefox is a ver-
satile tool that enables you to use Google’s products and services
with greater ease and better efficiency. To get the toolbar, open
Firefox or Internet Explorer and type in “toolbar.google.com”.
Google will automatically detect which browser you are using and
take you to the respective download page. The latest toolbar for
Firefox is version 2, and for Internet Explorer it is version 4. Both
toolbars behave in pretty much the same manner, with a few
minor differences.

14.1 The Firefox Toolbar

The Firefox toolbar has the following features:

m Enhanced Search box: As you type in the search terms you will
see suggestions that you can click on. You can also click the “G”
icon to choose any of Google’s services such as Images, Groups,
or News to search through.

m Custom Buttons: One-click buttons that will take you to many of
the popular Web sites can be added to the toolbar. Go to
http://toolbar.google.com/buttons/gallery to see the available
list of buttons and add them to your toolbar.

m Autolink will take you to a map of any address that is on the cur-
rent page. It is, however, restricted to US addresses only.

m Autofill enables you to enter all your personal information once,
and when you visit a site where you need to fill in a form with
your personal details, all you need to do is click the Autofill but-
ton to fill in the details.

Google Toolbar
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highlighted in yellow—making it easier for you to quickly see
where they are in all the text.

m Word Find Buttons: Each individual word in the search term
will be displayed as a button. Clicking on a particular word but-
ton will take you straight to the first occurrence of the word.
You can continue clicking to see all the subsequent occur-
rences of the word.

m Bookmarks: Integrated with Google Bookmarks, you can now
use the bookmark feature to keep track of all your favourite
sites without worrying about what will happen when you
change, upgrade, or switch between computers. Simply log in
to your Google account using the toolbar and your book-
marks will be available.

m Send to: This feature enables you to send any Web page via
Gmail or SMS (US only), or post to your blog in Blogger. You
can either send the entire page or a snippet. If it is a snippet,
just select the portion of text you want to send and then
choose “send to”.

m Google Account Sign In: You can use the Google toolbar to sign
into your Google account and get logged into all of Google’s serv-
ices. When signed in, a green light will light up next to Settings.

m Search settings notifier: If a piece of spyware or other malicious
software attempts to change your browser settings, you will be
notified by Google toolbar of the attempt.

To modify and control all the above features, click on the
Google button at the extreme left and select Options. The Google
Toolbar Options dialog box will pop up, which you can then use to
customise each of the above features and more.
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m Translate: By simply pointing at any English word on the page
you are viewing, this feature will translate that word into
Chinese (Traditional and Simplified), Japanese, Korean, French,
Italian, German, or Spanish.

m Address bar browse by name: You can also use the address bar
to enter your search term directly. For example, if you type in
“CNN” in the address bar, Google toolbar will guess that you
want to go to CNN.com and take you there. If you type in “camp-
ing equipment,” it will guess that you are looking for that, and
show you search results related to the term.

m Pop-up Blocker: The built-in pop-up blocker will block all pop-ups.

m Spellcheck: Whenever you type in a Web form, the Spellcheck
feature will verify the spelling of the words being typed, cur-
rently available for 12
languages. After typing
in your text, click the
Spellcheck button to
check for spelling mis-
takes. The mistakes will
be highlighted in red
bold underlines. The
Autofix option will cor-
rect the mistakes with a
single click and change
the colour to green
underlines. Once you are
done checking spellings,
click on an empty area of
the form and select
“Stop spell checking”.

m PageRank Display: Displays Google’s ranking of the current Web
site or Web page you are at. This is an automatically-generated
ranking based on Google’s site ranking algorithms.

m Highlight Search Terms: After getting a search results page
using the search box on the toolbar, click on the Highlight
marker icon, and all the relevant results on the page will be
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The Options dialog for the Firefox Toolbar
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14.3 The new Google toolbar—available in
Hindi too!

With the latest version of
the Google toolbar, users
can customise their search
in Hindi: Google Toolbar 4
for Internet Explorer is now
available in Hindi.

The new version of
Google toolbar enables
users to create, label, and
manage bookmarks for
favourite sites with a single
click. Bookmarks are now
saved to a user’s Google
account, making them
accessible from any computer. 

Additional product enhancements include expanded search
functionality, which offers instant search query suggestions. And
enhanced sharing capabilities allow users to easily send and share
Web page content through Gmail by selecting the section of the page
they want to share and simply clicking the new “send to” button.
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14.2 The IE toolbar

In the Internet Explorer toolbar, Translate is called Word
Translator. What’s missing in the IE Google Toolbar are Custom
Buttons, Address Bar browse by name, the pop-up blocker,
Bookmarks, Send to, Google Account Sign-in, and Search

Settings notifier. And the following aren’t there in the Firefox
toolbar:

m Google Safe Browsing will alert you if any of the sites you visit
are fraudulent.

m RSS Subscribe Icon: Whenever you are at a Web page that supports
RSS subscriptions, the feed icon will light up, and you will be able
to subscribe to the feed in your favourite Feed reader. Click the
down arrow next to the feed icon to select your Feed reader.

m Send with Gmail: You can make Gmail your default mail client
for all e-mail addresses with “mailto:” links. Clicking on any e-
mail ID will open a new Compose page in Gmail with the e-mail
ID entered in the “Send To” field.

m Custom Layouts: Three pre-set layouts are given to change the
layout of the toolbar. 

To modify and control all the above features, click on the
Settings button at the extreme right and select Options. The
Toolbar Options dialog box will pop up, which you can then use to
customise each of the above features and more.
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The IE Google Toolbar Options dialog
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Accessing Google via your cell phone or PDA is the ultimate in hav-
ing information at your fingertips while on the move. Liberated
from the Desktop and laptop, Google’s mobile services enable you
to search the Web, search the mobile Web (Web sites specially
designed for viewing on cell phones and PDAs), search images,
view news, and even check your Gmail. Even if the screen is
cramped and you need to become a finger acrobat with all those
buttons, nothing beats the convenience of being able to access all
this “anytime, anywhere.” Well, almost!

15.1 Mobile Device Requirements

To use Google’s mobile services, your mobile device should have a
Web browser that supports XHTML (WAP 2.0), WML (1.2) or iMode
(chtml). Normally, this is transparent to the user, and all you need
to do is type in www.google.com to access the Google search home
page. XHTML is the latest standard for mobile content, and sup-
ports both text and images. Most mobile devices bought in the last
two years should support this format. iMode also supports text
and images, and is a format primarily for the Japanese market. If
you bought your device direct from Japan, you can rest assured of
being able to access Google’s content even if it only supports
iMode. WML is an older format and only supports text. If you are
having trouble accessing the Web, try www.google.com/xhtml,
www.google.com/wml, or www,google.com/imode.

Depending on the Google service you wish to use, the mobile
device should also be set to accept cookies. Additionally, the
mobile network should allow cookies to be set as well and also
secure SSL traffic. Both these features are the responsibility of the
service provider. If you face any problems, check with your mobile
provider if they allow cookies to be set and to secure SSL traffic.

Google Mobile
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15.4 Image search

To search images, type in search term, scroll down, and highlight
the Images radio button. Then scroll back, select the Search but-
ton, and hit [Enter]. Similar to Web search and supporting all the
search operators that you use with PC image search, Google Image
Search on your mobile is streamlined for fast display. Up to three
images are displayed for each page of results.

15.5 Mobile Web search

Similar to regular Web search but restricted to content available
on mobile-ready sites only, type in your search term, scroll down
to select the Mobile Web radio button, scroll back to select the
Search button, and hit [Enter].

15.6 Froogle search (Labs)

This product is still in the cooking at Google Labs, but you can see
what it’s capable of now by going to http://wml.froogle.co.uk.

15.7 Google News

Access Google News by scrolling down on the homepage, selecting
the News link and hitting [Enter]. This will open the News home-
page. You can use the search box for specific topics, or read the
first headlines of the Top Stories section. Clicking on an article
link will take you to the Web site with the news story where you
can read the full story. You can also scroll down and select the
links that will take you to other items like all the top stories; you
can expand the other sections like Nation, World, Entertainment
etc. (see the chapter on Google News for details), or click on any of
the sections to get more stories from each section.

For general connectivity to the Internet and how to use your
mobile device’s Web browser, ask your mobile service provider and
refer the device’s user manual respectively. Note that when we say
“hit [Enter]” or “click the button” and so on, these correspond to
the functions that would normally done on a PC Web page. Mobile
phone browsers may differ in how they handle this functionality,
which should be explained in detail in the user manual. Also, be
prepared for slower response times than on your PC.

15.2 Preferences and Language Settings

Just like you do through your PC browser, you can set preferences
and language settings for your Google mobile interface. At the
Google homepage on your mobile browser, scroll through the
search box, the search button, the radio buttons, and the other
links, till you reach the Preferences link. Hit [Enter] and adjust
your language and safe search settings.

15.3 Web search

Google Web search via your cell phone or PDA is nearly the same
as searching on your computer, but there are some differences.
The obvious one is size. Google does a good job of intelligently tak-
ing the standard HTML content of the Web and re-formatting the
search results for easy readability and intuitive navigation,
depending on the screen size you have.

Type in your search term, highlight the Search button and hit
[Enter]. Up to ten search results are displayed per page. You can use
all the search operators that you would normally use with PC Web
search to refine your results.
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Once signed in, you can see your Inbox with the first 10 messages,
along with their subject headings. Click on any subject title to open
it and read the message. You can scroll down below the messages to
access other functions like Compose, Contacts and so on. The search
box at the bottom of the screen also helps in locating e-mail.

As with the Web version, once you open an e-mail, it will be
marked as read. Scroll down to the bottom of the message to choose
any of the various actions like Reply, Forward, Move to Trash, etc. 

Standard attachments viewable in a PC browser are also view-
able in the mobile browser. Simply select the attachment (Word,
PDF, etc.) and hit [Enter] to view it. Note that Excel and other
spreadsheet attachments will not display correctly unless the for-
mat is extremely simple. This is due to the inherent limitations of
the mobile browser’s display medium when it needs to display
large quantities of text arranged in the spreadsheet format.

15.9.2 Access via J2ME Java Application

If you have one of the new Java-enabled (MIDP2) mobile devices,
and your phone has the Verisign Class 3 public certificate with
serial number 70:BA:E4:1D:10:D9:29:34:B6:38:CA:7B:03:CC:BA:BF,
you can use the Gmail J2ME application. To download and install
the application, go to www.gmail.com/app. To verify these details
and to learn how to down and install Java applications on your
mobile phone, check with your device’s user manual.

This J2ME Gmail application is much faster than going through
the mobile browser. Additionally, it works exactly like Gmail and
has the same look and feel, making it much easier to work with
when viewing, reading and replying to emails. However, note that
if you’re signed in, the application will constantly consume band-
width, since it will keep checking your account for fresh mail. To
prevent this from happening, you will need to explicitly quit the
application by going to Menu > Exit Gmail.

At the bottom of the screen, you can change your regional set-
tings to show content from any of the regional editions currently
available at Google News.

15.8 Personalized Home Page

In your mobile browser, type in http://www.google.com/xhtml. This
will open the default Google homepage (US). Scroll down the choic-
es till you highlight the link Personalized Home, then hit [Enter].
This will take you to the Google account login page, and you will be
prompted to enter your username and password. Enter the required
details, select the checkbox “Remember me”, and click “Sign in”.
The mobile-supported gadgets on your personalised home page will
be displayed. For example, if you’ve added Gmail and Top Stories
from Google News to your Personalized homepage (via the PC), the
first few e-mails from your Gmail Inbox and a list of headlines from
the Top Stories section in Google News will be displayed. Gadgets
that do not have mobile browser support will not be displayed.

15.9 Gmail

There are two ways to access Gmail on your mobile device—direct-
ly through your mobile Web browser, or by downloading and
installing a J2ME Java application.

15.9.1 Access via Web 
Do one of the following:
m Type in http://gmail.com
m Type in http://mail.google.com 
m Type in http://m.gmail.com 
m Select Gmail from the Google home page 
m Select Gmail from your Personalised home page. 

Note that your mobile browser should be XHTML-compliant to
access Gmail. If you haven’t already saved your login information,
you will be prompted to sign in with your user details.

DT - Chapter 15 (Google Mobile).qxd  5/12/2008  1:57 PM  Page 142



16GOOGLE NEWS

145

GOOGLE

The conventional way to read the top stories of the day is to pick-
up your favourite newspaper—or more appropriately in this online
age—is to visit your favourite news Web site. There is, however, a
drawback with this approach: the news you read is limited to a sin-
gle publisher’s perspective.

Google News (news.google.com) attempts to be different.
Rather than be limited to the views of a single publisher, Google
News works on the principle that there is more than one news
source for the same story. Thus, stories are grouped together
around one news event than around any one particular news
provider. The cool part is, the process is automated. Google’s com-
puters scan over 4,500 English-language news sources to collate
stories of the past 30 days and to display them according to the
user’s personalisation.

With its usual gusto for content engineering, Google’s com-
puters evaluate and rank the stories based on their heady brew
of clustering algorithms (http://tinyurl.com/yh8697) using multi-
ple parameters to judge a story’s newsworthiness. This suppos-
edly provides one with an unbiased, non-political, non-ideologi-
cally-driven news engine that is customisable to reflect your per-
sonal interests. While detractors will say that a mix of news
sources, collectively without a point of view, is like a bland dish,
we like to think that Google News provides all the ingredients to
whip up our own personalised dish of spicy news served steam-
ing hot over data pipes!

But before we delve in for a deeper look at its features there
may be some of you who are wondering if it is only an “English
Affair.” Well, there is good news and bad news. The good news is
that Google News is available in a large number of international
languages and regional editions. India is one of the regional edi-
tions, but with a caveat (this is the bad news): as of now, it’s only

Google News
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You search for news topics using keywords, much like you
would on other Google sites. The results are displayed by relevance
by default; they can also be sorted by date by clicking on the “Sort
by date” link at the upper right corner. Also, all Google News
search results can be distributed as an RSS feed (see §16.3 for
details), the search keywords can be used to personalise your
Google News homepage (see §16.2 for more), and the search key-
words can also be used to create e-mail alerts (see Chapter 13 to
learn how).

Each news clip displays a text snippet from the Web site of
the highest ranked (by Google) news source. Clicking on the
headline will take you directly to the Web site with the news
story. Immediately below the text snippet, clickable headlines to
the same story from the second- and third-ranked news Web site
are displayed.

Below these are links to the other top sites containing the
same story. Finally, below these links, you will find a link to all
news articles on the same story. If you are on a slow connection,
you can speed up the display somewhat by switching to the text-
only version: click on the “Text Version” link in the left pane. You
can control the display of text snippets and thumbnails plus lots
more by using the customisation and personalisation features
that Google News supports. 
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available English. Don’t be too disheartened though: as the Web
becomes more” Googlified,” we hope you will be soon able to see
Google News in your favourite language! 

Meanwhile, recommend to Google your favourite regional lan-
guage news sites by going to www.google.com/support/news
/bin/request.py.

16.1 Anatomy Of A Google News Clip

The standard Google News homepage is divided into a number of
topics headlined by Top Stories, followed by eight other topics or
“standard sections” as they are called, which relate to the follow-
ing subject areas: World, Nation (country-specific), Business,
Sci/Tech, Sports, Entertainment, Health, and Most Popular.

The standard sections are customisable in a number of ways
explained in more detail in the Personalisation section in chapter 7.
Under each section, text clips from the leading stories are displayed.
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The Google News home page

Your typical news clip
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done so. If you are not sure about what we are talking about
here, take a look at §7.4. The Personalized Search History saves all
your searches. It works in the background to enhance your
search experience by customising your search results based on
the history of your searches (which make up a pattern), among
other things. This is applicable to Google News as well. By log-
ging in and activating personalised search, Google News will
switch on a feature called Recommended Stories, which will
appear right below the Top Stories section.

The Personalized Search history keeps track of the news you
read, and as Google News gets an idea about your tastes and
interests, the Recommended Stories section will begin to fill up
with news that better reflects your tastes and interests. You can
also click on the section heading to take you to a full page of rec-
ommended stories.

You personalise your news home page by clicking on the
“Personalize (or Customize) this page” link at the top right side
below the “Top Stories” banner. In the window that opens, you can
drag the sections to rearrange the layout, click on each section to
change it or delete it, add a new standard section, or create a cus-
tom section based on the search terms you specify.

For an example, we’ve
decided to create a custom
search section called “Zune
Tracker” to track all the top
news stories related to
Microsoft’s new media player,
Zune. 

In the keywords section, we
specify “zune” as the keyword
that Google News should
search for in the news stories.
Keyword search, by default,
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16.2 Personalisation

Personalisation enables you to mix and match the standard sec-
tions from across the 35 regional editions, along with custom
sections created by the user. The standard Google News home-
page shows you the US edition, which can be changed by click-
ing on the drop-down next to Top Stories and choosing the
region of your choice.

Personalisation is possible even without signing in to your
Google account. Doing this, however, will make it specific to the
computer and browser you’re using. For example, if you regu-
larly use Firefox and if for some reason want to switch to Opera
for a while, the personalisation settings won’t be available in
Opera. The same goes for when you open Google News on anoth-
er computer. There is, however, a workaround to this problem
(See box Hack: Multiple Personalised Versions Of Google News).

To eke the maximum out of personalisation, however, you’ll
need to log in to your Google account. Also, while you are at it,
activate your Personalized Search History if you haven’t already
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Google recommends news stories for you Configure the custom section
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Our newly-created, custom search section “Zune Tracker” will
now gather and display all the top news stories where the keyword
“zune” appears.

By clicking on the edit link at the top right of the section, this
custom section—or for that matter, any section—can be further
customised to suit your specific requirements as they change over
time. Likewise, you can create more custom sections, but with an
upper limit of 20, which is inclusive of both the standard and cus-
tom sections.

The personalised news pages created above are not stored in
your Google account. The Recommended Stories feature won’t be
enabled; that is linked to your Personalized Search history, which
in turn requires that you be logged in to your Google account. You
can also share your Google-account-linked news home page by
using the above procedure.

The default view is to show the news headline with a snippet
of the text and thumbnail image from the story. This, however
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searches for all keywords in the search term. You can use the OR
operator and/or the exclusion operator, the minus sign. You can
also use advanced search operators to create a section. Simply
create your advanced search term as explained in §16.4, verify
that the search results are satisfactory, then cut and paste the
entire search term into the keyword field.

With the Advanced option, you can further narrow it down to
supported languages and specific, standard sections such as
Sci/Tech or Business. You can specify the optional label “Zune
Tracker” so you can easily identify it on the page. If you don’t
specify a label, one will be automatically created based on the
keywords you have used. Finally, after saving the changes to this
new custom section, you drag “Zune Tracker” to the top to make
it make it quicker to scroll. Click “Save Layout”.
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The News home page with custom sections

Hack: Multiple Personalised Versions Of Google News 

1. Sign out of Google.
2. Click on the “Customize (or Personalize) this page” link and cus-

tomise it as you want to see it
3. Save your changes
4. Scroll down to the bottom of the page and click the “Share your

personalized news with a friend” link. A yellow box will expand
on the page with the unique link address for your personalised
homepage. Bookmark the link and rename the bookmark to
something descriptive. You can even store it in your Google
Bookmarks. See §7.4 for more details on how to use Google
Bookmarks.

5. Even better, you can add the links to your favourite feed reader
(like Google Reader—see Chapter 10) and keep getting the news
feeds delivered directly. Be sure to rename the feed title to dis-
tinguish it from regular Google News feeds.

6. Clear the personalised settings and repeat with whatever varia-
tions you want.
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16.4 Searching Google News

As with other Google search services, Google News supports most
of the search operators listed in §7.1.7. As far as the text operators
go, however, Google News is limited to the following: allintext:,
allintitle:, allinurl:, intext:, intitle:, inurl:, location:, and source:.
The operators location: and source: are limited to Google News,
and they can be used as follows:

You can also use the Advanced News Search page to refine your
search query with the above operators and restrict your search to
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reduces the amount of content shown on the screen. If you wish
to see more headlines, you can turn off the text and images that
accompany each headline. Click on the “Edit this customized
page” link and click on “Show headlines only” at the bottom of
the window. You can also remove all customisations and revert to
the Google default by clicking on “Reset page to default” link in
the customisation window.

16.3 RSS Feeds

Feeds are regularly updated Web content that is “pulled” to your
computer through a feed reader like Google Reader. This saves you
the trouble of having to visit each of your favourite Web sites to
view the latest content. Browsers like Firefox and Internet Explorer
7, as well as Google Toolbar, support the ability to recognise and
subscribe to content on feed-enabled sites.

All the news on Google News is available as aggregate or indi-
vidual section-wise feeds. That is, you can separately subscribe to
each standard or custom section that you create, or subscribe to
your entire Google News homepage from your favourite RSS read-
er. Copy the URL to your feed reader, click on the Feed icon, or use
the appropriate method for your reader to subscribe to the feed.

You can also create customised news feeds for any search topic.
This feature has some very important uses. For example, to keep
track of the latest medical news on hip replacement, run a query for
the search term “hip replacement”. The search results can then be
saved as a feed. This feature will then enable you to keep abreast of
the latest news on that subject, which is delivered to your feed read-
er as it is published. Note that you can use Google Alerts to achieve
the same result, but in a different delivery format: the search results
are send to your Gmail Inbox based on the frequency you specify.
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The advanced news search

Operator
source:

location:

Meaning
Limit search to
the specified
source

Limit search to
specific country
or US state

Example
zune source:
times_of_india

Zune
location:India

Explanation
Search for the news
stories with the
word “zune” restrict-
ed to the news
source “Times of
India”
Search for news sto-
ries with the word
“zune” restricted to
the news location
“India”
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first. These dates are Google’s recommendation on what the rele-
vant time-period in history is.

As with other Google search services, you can also use
Advanced News Archive Search to narrow and refine your results. 

You can restrict your search by date, language, news source, or
article price. If you switch to timeline view, the news source and
article price fields are disabled. For more on using search opera-
tors on Google News see §16.4.
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any period within the current and pervious month.

You can create a custom section as explained in §16.2 by using
the keywords in your search. 

16.5 News Archive Search

News Archive Search (http://news.google.com/archivesearch) is
one of the most innovative features of Google News. 

With archive search, you can even get access to news reports
that are as many as 200 years old! Google’s aim with News Archive
Search is to enable users to search its news archives for historical
content related to almost anything. Ideas, events, people are all
searchable for a historical perspective spanning multiple news
sources that will give you a flavour of the era better than any his-
tory book! The results can also include links to free articles as well
as paid articles. Normally, the link title itself will suggest if there
is payment involved. Clicking on a paid link will not incur any cost
and you can usually see a preview or snippet of the article content
before to let you decide whether it is worth paying for.

Articles are viewable as both standard articles grouped accord-
ing to years with the latest first or as a timeline with the oldest
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The Google News archive search home page

WATCH OUT!!
for Advanced 
Features of

Google
next month
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